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Preface

BayRS* Version 15.5.0.0 is a software release that includes bug fixes and new 
features added since BayRS Version 15.4.0.0. This document change notice 
contains amendments to the following BayRS manuals since BayRS Version 
15.1.0.0:

• BayRS Online Library

• Configuring and Managing Routers with Site Manager

• Configuring ATM Services

• Configuring Bridging Services

• Configuring Data Compression Services

• Configuring Differentiated Services

• Configuring DLSw Services

• Configuring Ethernet, FDDI, and Token Ring Services

• Configuring Frame Relay Services

• Configuring GRE, NAT, RIPSO, and BFE Services

• Configuring IP, ARP, RIP, RARP, and OSPF Services

• Configuring IP Multicasting and Multimedia Services

• Configuring PPP Services

• Configuring RADIUS

• Configuring the Technician Interface Scripts

• Configuring the Technician Interface Software

• Configuring Traffic Filters and Protocol Prioritization

• Configuring VRRP Services
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• Configuring X.25 Services

• Quick-Starting Routers

• Upgrading Routers to BayRS Version 15.x

Before you begin

Before using this guide, you must complete the following procedures. For a new 
router:

• Install the router (see the installation guide that came with your router).

• Connect the router to the network and create a pilot configuration file (see 
Quick-Starting Routers, Configuring Remote Access for AN and Passport 
ARN Routers, or Connecting ASN Routers to a Network).

Make sure that you are running the latest version of Nortel Networks* BayRS and 
Site Manager software. For information about upgrading BayRS and Site 
Manager, see the upgrading guide for your version of BayRS.

Text conventions

This guide uses the following text conventions:

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command.

Example: If the command syntax is:
ping <ip_address>, you enter:
ping 192.32.10.12

bold text Indicates command names and options and text that 
you need to enter.

Example: Enter show ip {alerts | routes}.

Example: Use the dinfo command. 
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Preface
  
Acronyms

This guide uses the following acronyms:

braces ({}) Indicate required elements in syntax descriptions 
where there is more than one option. You must choose 
only one of the options. Do not type the braces when 
entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you must enter either:
show ip alerts or show ip routes, but not both.

italic text Indicates new terms, book titles, and variables in 
command syntax descriptions. Where a variable is two 
or more words, the words are connected by an 
underscore.

Example: If the command syntax is:
show at <valid_route>
valid_route is one variable and you substitute one value 
for it.

separator ( > ) Shows menu paths. 

Example: Protocols > IP identifies the IP option on the 
Protocols menu. 

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not type 
the vertical line when entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you enter either:
show ip alerts or show ip routes, but not both.

ARN Advanced Remote Node

ARP Address Resolution Protocol

AS autonomous system

ASE autonomous system external
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ATM asynchronous transfer mode

DLSw data link switching

DSCP Differentiated Services Code Point

DSQMS differentiated services queue management and 
scheduling

FDDI Fiber Distributed Data Interface

GRE Generic Routing Encapsulation

HSSI High Speed Serial Interface

IP Internet Protocol

IPsec Internet Protocol Security

LCP Link Control Protocol

LLC logical link control

LMI Local Management Interface

LQR Link Quality Report

LSA link state advertisement

LSDB link state database

MTU maximum transmission unit

NAT Network Address Translation or
Network Address Translator

NLPID network layer protocol identifier

NSSA not-so-stubby area

OSPF Open Shortest Path First

PBBI PIM bootstrap border interface

PBBR PIM bootstrap border router

PIM Protocol Independent Multicast

PMC PCI mezzanine card

PPP Point-to-Point Protocol

PVC permanent virtual circuit

QLLC Qualified Logical Link Control

RADIUS Remote Access Dial-In User Services
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Preface
  
Hard-copy technical manuals

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to the www.nortelnetworks.com/documentation URL. Find the 
product for which you need documentation. Then locate the specific category and 
model or version for your hardware or software product. Use Adobe* Acrobat 
Reader* to open the manuals and release notes, search for the sections you need, 
and print them on most standard printers. Go to Adobe Systems at the 
www.adobe.com URL to download a free copy of the Adobe Acrobat Reader.

How to get help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact Nortel Networks 
Technical Support. To obtain contact information online, go to the 
www.nortelnetworks.com/cgi-bin/comments/comments.cgi URL, then click on 
Technical Support.

From the Technical Support page, you can open a Customer Service Request 
online or find the telephone number for the nearest Technical Solutions Center. 
If you are not connected to the Internet, you can call 1-800-4NORTEL 
(1-800-466-7835) to learn the telephone number for the nearest Technical 
Solutions Center.

RARP Reverse Address Resolution Protocol

RIP Routing Information Protocol

SRB source route bridge

SVC switched virtual circuit

TOS type of service

VC virtual circuit

VRRP Virtual Router Redundancy Protocol
314470-15.5 Rev 00 xvii

http://www.nortelnetworks.com/cgi-bin/comments/comments.cgi
http://www.nortelnetworks.com/documentation
http://www.adobe.com
http://www.adobe.com


BayRS Version 15.5.0.0 Document Change Notice
An Express Routing Code (ERC) is available for many Nortel Networks products 
and services. When you use an ERC, your call is routed to a technical support 
person who specializes in supporting that product or service. To locate an ERC for 
your product or service, go to the http://www.nortelnetworks.com/help/contact/
erc/index.html URL.
xviii 314470-15.5 Rev 00
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Chapter 1
BayRS Online Library

Version 15.4.0.0

The Installing BRI Net Modules in ASN Platforms (Part No. 115371-A) has been 
updated since the BayRS Online Library (Part No. 314472-A) documentation CD 
was last issued. The revised Installing BRI Net Modules in ASN Platforms (Part 
No. 115371-B) has replaced all references to Bay Networks with references to 
Nortel Networks.

You can access the latest version of this document on the Nortel Networks 
Technical Documentation Web page. See the following section, “Accessing Nortel 
Networks Technical Documentation on the Web” for instructions.

Accessing Nortel Networks Technical Documentation on the Web

Complete the following steps to access the latest version of documentation on the 
Web that may not be reflected on the BayRS Online Library documentation CD.

1. Go to http://www.nortelnetworks.com.

2. Select Technical Documentation, under Products, Services and Solutions. 

3. If you have not previously done so, specify your region and language 
preferences.

4. At By Product Family, select one of the following:

• BayRS Router Software (for Nortel technical publications (NTPs) 
associated with software releases). When you select this link, you go to 
the list of software documentation categories shown in Table 1-1. If you 
select this link, go to step 5.
314470-15.5 Rev 00 1-1
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• BayRS Routers (for NTPs associated with hardware releases). When you 
select this link, you go to the list of available hardware documents shown 
in Table 1-2. If you select this link, go to step 6.

5. Click the link for the software documentation category (from Table 1-1) 
that you want. When you click a category link, you go to the list of 
available documents for that software category.

6. Click the PDF link for the document that you want to view or download.

Table 1-1. Documentation Categories Available from the BayRS Router 
Software Link

BayRS Routers Documents (hardware)

BayRS Router Software: General Availability

BNX-BayStream Router Software (Documentation)

BNX-BayStream Site Manager Software (Documentation)

Router Software v 13.x (Documentation)

Router Software v 14.x (Documentation)

Router Software v 15.x (Documentation)

Site Manager (Documentation)

BLN-BCN LAN Link Modules (Documentation)

BLN-BCN WAN Link Modules (Documentation)

Passport 2430 Router (Documentation)

Passport 5430 Router (Documentation)

Passport Advanced Remote Node (ARN) Router (Documentation)

BayRS Router Software: End of Life-Retired 

Router Software v 1-5 (Documentation)

Router Software v 11-12 (Documentation)

Router Software v 6-10 (Documentation)
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Table 1-2. Documents Available from the BayRS Routers Link 
(Hardware)

BayRS Routers: General Availability

Access Stack Node (ASN) Router (Documentation)

Backbone Concentrator Node (BCN) Router (Documentation)

Backbone Link Node (BLN) Router (Documentation)

Backbone Node (BN) Router Portfolio (Documentation)

Backbone Node VNR (Documentation)

BLN-BCN ATM Link Modules (Documentation)

BLN-BCN LAN Link Modules (Documentation)

BLN-BCN WAN Link Modules (Documentation)

Passport 2430 Router (Documentation)

Passport 5430 Router (Documentation)

Passport Advanced Remote Node (ARN) Router (Documentation)

BayRS Routers: Manufacture Discontinued 

Access Node (AN) and Access Node Hub (ANH) Routers (Documentation)

System 5000 Router Modules (Documentation)
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Chapter 2
Configuring and Managing
Routers with Site Manager

Version 15.3.0.0

The following section is an amendment to Chapter 7, “Monitoring Trap and Event 
Messages” in Configuring and Managing Routers with Site Manager.

Changing the Trap Port for 
Multiple Network Management Applications

If you are running more than one network management application on your Site 
Manager workstation, you must configure Site Manager to receive trap messages 
from the SNMP agent on a port other than the default port, 162. This is necessary 
for the following reasons:

• The agent can only send trap messages to one network management 
application at a time.

• Only one application can map to a UDP port at a time.

By default, the network management application on your workstation is 
assigned to User Datagram Protocol (UDP) port 162. This port is dedicated to 
receiving SNMP trap messages from the SNMP agent. 

Site Manager is the preferred network management application for receiving 
trap messages. To avoid any problems when running another network 
management application, Nortel Networks recommends that you configure 
Site Manager to map to an alternative UDP port. This allows you to send trap 
messages to Site Manager directly.
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To reconfigure the trap port:

1. In the Configuration Manager window, choose Protocols > IP > 
SNMP > Communities.

The SNMP Community List window opens.

2. Choose Community > Managers.

The SNMP Manager List window opens.

3. Choose Manager > Edit Manager.

The Trap Port and Trap Types window opens.

4. Type a new port number for the Trap Port parameter, then click on OK.

You can enter any port number on your Site Manager workstation, as long as 
another application is not using that port.

You return to the Configuration Manager window.

5. Choose File > Save to save this configuration file.

See Chapter 3 in Configuring and Managing Routers Using Site Manager for 
instructions on saving configuration files.

6. Choose File > Exit.

You return to the main Site Manager window.

7. Restart Site Manager according to the instructions in Chapter 1 of 
Configuring and Managing Routers Using Site Manager

To make sure that Site Manager is able to listen to the port that you configured 
in step 4, restart Site Manager using the wfsm -e command or the Trap 
Monitor using the wftraps -e command. For more information, about using 
the wfsm and wftraps commands with the -e option, see Appendix A in 
Configuring and Managing Routers with Site Manager.

Note: You can also change the trap port on a PC by editing the 
snmp-trap 162/udp snmp string in the Services file. From the Start menu, 
choose Programs > Windows Explorer. Open the Services file and edit the 
string snmp-trap 162/udp snmp. For example, to change the trap port from 162 
to 779, enter snmp-trap 779/udp snmp and reboot the PC. Site Manager PC 
is then able to receive the traps from the router on port 779.
2-2 314470-15.5 Rev 00



  
Chapter 3
Configuring ATM Services

Version 15.2.0.0

The following section is new to Configuring ATM Services. You use the 
procedures in this section to configure an ATM T3/E3 PMC module installed in a 
Passport* 5430. For information about installing an ATM T3/E3 PMC module, 
see ATM T3/E3 PMC Module Supplement.

Creating an ATM Circuit for a T3 or E3 Connection on a Passport 5430

To start ATM services on an ATM T3/E3 PMC module in the Passport 5430, you 
do the following: 

1. Configure the physical ATM circuit. 

2. Add protocols and other services to that circuit. 

This section describes how you create a physical ATM circuit for a T3 or E3 
connection on a Passport 5430, then directs you to Configuring ATM Services for 
information about adding protocols and further configuring ATM services. 

Using the BCC

To add ATM to a Passport 5430 with a T3/E3 connector, navigate to the box 
prompt and enter:

atm slot <slot_number> pci-slot <pci_slot> module <module_number> 
connector <connector_number> mode {t3 | e3}

slot_number is the number of the chassis slot containing the ATM T3/E3 PMC 
module.
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pci_slot is the number of the PCI slot containing the ATM T3/E3 PMC module. 
The PCI slot number for the ATM T3/E3 PMC module is always 1.

module_number is always 2 for the ATM interface.

connector_number is the number of a connector on the ATM T3/E3 PMC module.

mode t3 or mode e3 specifies whether the ATM interface is a T3 or E3 interface.

For example, the following command adds an ATM T3 interface to the Passport 
5430 configuration on slot 1, PCI slot 1, module 2, connector 1:

box# atm slot 1 pci-slot 1 module 2 connector 1 mode t3
atm/1/1/2/1#

To configure T3/E3 parameters, use the following procedures.

Specifying the Cable Length

To specify the cable length, navigate to the ATM interface prompt (for example, 
box; atm/1/1/2/1; atm-e3) and enter:

cable-length <length>

length is either short (default) or long. Specify short for a cable less than 225 feet 
long; specify long for a cable length of 225 feet or more.

For example, the following command changes the cable length to long:

atm-e3/1/1/2/1# cable-length long
atm-e3/1/1/2/1#

Specifying the Clear Alarm Threshold

To specify the duration of time (in seconds) that elapses following the clearing of 
a performance failure (before the condition is registered and logged), navigate to 
the ATM interface prompt (for example, box; atm/1/1/2/1; atm-e3) and enter:

clear-alarm-threshold <integer>

integer is a value from 2 through 10 seconds, inclusive. 
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For example, the following command changes the clear alarm threshold from 2 to 
8 seconds:

atm-e3/1/1/2/1# clear-alarm-threshold 8
atm-e3/1/1/2/1#

Specifying the Line Coding Method

To specify the line coding method, navigate to the ATM interface prompt (for 
example, box; atm/1/1/2/1; atm-e3) and enter:

line-coding {hdb3 | b3zs}

The default for the ATM E3 interface is hdb3 and the default value for the ATM 
T3 interface is b3zs.

Specifying the Line Type

To specify the line type for this interface, navigate to the ATM interface prompt 
(for example, box; atm/1/1/2/1; atm-e3) and enter:

line-type <type>

type is autodetect, ds3m23, or ds3cbitparity for the ATM T3 interface and 
e3framed or e3plcp for the ATM E3 interface. 

If the line type is ds3m23, the framing mode should be m23 or t3m23plcp. 

If the line type is ds3cbitparity, the framing mode should be cbit or t3cbitplcp. 

If the line type is either e3framed or e3plcp, the framing mode should be either 
g751or g832.

For instructions on setting the framing-mode parameter, see Configuring ATM 
Services.

Specifying the Loopback Mode

To force the interface into loopback mode so that the far-end or intermediate 
equipment can perform diagnostics on the network between that equipment and 
the T3/E3 interface, navigate to the ATM interface prompt (for example, box; 
atm/1/1/2/1; atm-e3) and enter:

loopback-mode <type>
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type is payloadloop or lineloop. 

If you select payloadloop, the received signal at this interface is looped through 
the device. Typically, the received signal is looped back for retransmission after it 
has passed through the device’s framing function. 

If you select lineloop, the received signal at this interface does not go through the 
framing device (minimum penetration) but is looped back out. The default is 
noloop.

For example, the following command changes the loopback mode to payloadloop:

atm-e3/1/1/2/1# loopback-mode payloadloop
atm-e3/1/1/2/1#

Defining the Interface MTU

The maximum transmission unit (MTU) is the largest possible unit of data that the 
physical medium can transmit. By default, the interface allows an MTU size of 
4608 octets. This value can handle most packet sizes. However, you can set the 
MTU to any value from 3 through 4608 octets.

To modify the interface MTU, navigate to the ATM interface prompt (for 
example,
box; atm/1/1/2/1; atm-e3) and enter:

mtu <integer>

integer is the MTU size in octets.

For example, the following command sets the MTU size to 3000 octets:

atm-e3/1/1/2/1# mtu 3000
atm-e3/1/1/2/1#

Defining the Primary Clock Source

To define the clock signal source, navigate to the ATM interface prompt (for 
example, box; atm/1/1/2/1; atm-e3) and enter:

primary-clock-source <value>

value is internal or loop. If you select internal, the router will generate the clock 
signal source. If you select the default, loop, the clock signal source will be 
external to the router.
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For example, the following command sets the clock source to internal:

atm-e3/1/1/2/1# primary-clock-source internal
atm-e3/1/1/2/1#

Specifying the Setup Alarm Threshold

To specify the duration of time (in seconds) that elapses following the detection of 
a performance failure, before the condition is registered and logged, navigate to 
the ATM interface prompt (for example, box; atm/1/1/2/1; atm-e3) and enter:

setup-alarm-threshold <integer>

integer is a value from 2 through 10 seconds, inclusive. 

For example, the following command changes the setup alarm threshold from 2 to 
8 seconds:

atm-e3/1/1/2/1# setup-alarm-threshold 8
atm-e3/1/1/2/1#

Disabling and Reenabling the ATM interface

By default, the ATM interface is enabled when you create the circuit. However, 
you can disable or reenable the interface at any time. When the interface is 
enabled, traffic can flow over the interface. When the interface is disabled, traffic 
cannot flow over the interface.

To disable or reenable the ATM interface, navigate to the ATM interface prompt 
(for example, box; atm/1/1/2/1; atm-e3) and enter:

state {disabled | enabled}

For example, the following commands disable and reenable the ATM interface:

atm-e3/1/1/2/1# state disabled
atm-e3/1/1/2/1# state enabled
atm-e3/1/1/2/1#
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Using Site Manager

To create an ATM circuit for a T3 or E3 connection on a Passport 5430, complete 
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM DS3/E3 interface (ATM1) 
in slot 1, PCI slot 1, module 2.

The Add Circuit window opens.

2. Click on OK to accept the default circuit 
name.

The ATM Configuration window opens.

3. Click on Physical Layer Configuration. The Physical Layer Configuration window 
opens.

4. Click on either DS3 or E3. The Port Parameters window opens.

5. To configure port parameters, set the 
following parameters as needed:
• Enable/Disable
• Line Type
• Setup Alarm Threshold (seconds)
• Clear Alarm Threshold (seconds)
• Loopback Configuration
• Primary Clock
Click on Help or see the parameter 
descriptions in “ATM Line Parameters,” 
beginning on page A-3.

6. Click on OK. The Physical Layer Configuration window 
opens.

7. Click on Done. The ATM Configuration window opens.

8. Click on ATM Line Attributes. The ATM Line Driver Attributes window 
opens.

(continued)
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After you create the ATM circuit, go to Chapter 2, “Starting ATM and ATM 
Router Redundancy,” in Configuring ATM Services to finish configuring ATM 
services.

Configuring ATM Services also provides more information about ATM services 
and how to modify an existing ATM configuration.

9. Set the the following parameters as 
needed:
• Enable
• Interface MTU
• Data Path Enable
• Data Path Notify Timeout
• Framing Mode
• Cell Scrambling
• Per-VC Clipping
• DS3 Line Build Out
Note: The Cell Scrambling parameter 
value must be the same as for the other 
ATM devices on your network. See your 
system administrator or your service 
provider for the appropriate value.

Click on Help or see the parameter 
descriptions in “ATM Line Parameters” on 
page A-3.

10. Click on OK. The ATM Configuration window opens.

11. Click on ATM. The Edit ATM Connector window opens.

12. Go to “Defining an ATM Service Record” in 
Configuring ATM Services.

Site Manager Procedure (continued)

You do this System responds
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Version 15.3.0.0

The following sections contain amendments to Chapter 3, “Customizing an ATM 
Interface” in Configuring ATM Services.

Defining the SVC Inactivity Timeout

When you enable the SVC inactivity timeout function (the default), the router 
automatically terminates any SVCs that have not received or transmitted any cells. 
If you disable the SVC inactivity timeout function, all SVCs on the line remain 
open until you close them by another method.

When enabled, the SVC inactivity timeout function also requires a timer value. 
This timer value specifies how long you want the ATM router to wait before 
disabling inactive SVCs. By default, if the router does not receive or transmit any 
cells for 1200 seconds, the inactive SVCs are disabled. However, you can set this 
timer to any value from 60 to 3600 seconds.

Using the BCC

To disable the SVC inactivity timeout function, navigate to the ATM prompt (for 
example, box; atm/11/1) and enter:

vc-inactivity-control disabled

For example, the following command disables the SVC inactivity timeout 
function on the ATM interface:

atm/11/1# vc-inactivity-control disabled
atm/11/1#

To reenable the SVC inactivity timeout function, navigate to the ATM prompt and 
enter:

vc-inactivity-control enabled

Note: The vc-inactivity-control parameter is not available for use with the 
ATM T3/E3 PMC module. Instead, the vc-inact-control parameter appears for 
this module. The vc-inact-control parameter cannot be modified.
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To change the SVC inactivity timeout value, navigate to the ATM prompt and 
enter:

vc-inactivity-timeout <integer>

integer is the amount of time (in seconds) that the router waits before it disables 
inactive SVCs.

For example, the following command sequence reenables the SVC inactivity 
timeout function on the ATM interface and sets the SVC inactivity timeout value 
to 2400 seconds:

atm/11/1# vc-inactivity-control enabled
atm/11/1# vc-inactivity-timeout 2400
atm/11/1#

Note: The vc-inactivity-timeout parameter is not available for use with the 
ATM T3/E3 PMC module. Instead, the vc-inact-timeout parameter appears 
for this module. The vc-inact-timeout parameter cannot be modified.
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Defining the Clocking Signal Source

You can specify either an internal or external clocking source for time signals. 
Internal clocking uses the router clock; external clocking uses the line clock.

Using the BCC

To change the source of the ATM clocking signal, navigate to the ATM prompt 
(for example, box; atm/11/1) and enter:

clock-signal-source <source>

source is either internal (default) or external.

For example, the following command changes the ATM clocking signal source to 
external:

atm/11/1# clock-signal-source external

atm/11/1#

Note: The clock-signal-source parameter is not available for use with the 
ATM T3/E3 PMC module. Instead, the clk-signal-source parameter appears 
for this module. The clk-signal-source parameter cannot be modified.
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Version 15.5.0.0

The following sections contain amendments to Chapter 3, “Customizing an ATM 
Interface” in Configuring ATM Services.

Turning DS-3 and E3 Cell Scrambling On and Off

Beginning with BayRS version 15.5.0.0, the BCC parameter used to turn ATM 
cell scrambling on and off for DS-3 and E3 interfaces has a new, more specific 
name. To eliminate confusion, the scrambling parameter is now named 
ds3e3-scrambling. 

The default value (off) for the ds3e3-scrambling parameter (ATM cell 
scrambling feature) remains the same.

The procedure for using Site Manager to configure ATM cell scrambling on DS-3 
and E3 interfaces has not changed.

Using the BCC

To turn on cell scrambling for a DS-3 or E3 interface, navigate to the ATM prompt 
(for example, box; atm/11/1) and enter:

ds3e3-scrambling on

For example, the following command turns on cell scrambling for ATM connector 
1 in slot 11:

atm/11/1# ds3e3-scrambling on
atm/11/1#

To turn cell scrambling off, navigate to the ATM prompt and enter:

ds3e3-scrambling off

Note: ATM cell scrambling is supported only for DS-3 and E3 interfaces. 
Attempts to configure the ds3e3-scrambling parameter on other interfaces 
(for example, OC-3 interfaces), generates the following error message:
Scrambling can be modified only for DS3/E3 Interface.
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For example, the following command turns cell scrambling off for ATM connector 
1 in slot 11:

atm/11/1# ds3e3-scrambling off
atm/11/1#
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Chapter 4
Configuring Bridging Services

Version 15.2.0.0

The following section corrects an error in Configuring Bridging Services.

Interfaces Supported

The section “Interfaces Supported” under “Implementation Notes” in Configuring 
Bridging Services incorrectly states that the translation bridge can operate on all 
Source Routing (SR) interfaces supported by Nortel Networks routers except IP. 
The translation bridge can operate on all SR interfaces supported by Nortel 
Networks routers except for interfaces configured for SRB with IP encapsulation.

Version 15.5.0.0

The following section corrects an omission in the “Customizing Global Source 
Routing Bridge Parameters” section of Chapter 7, “Configuring Source Routing 
Bridge Services Using the BCC” in Configuring Bridging Services.
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Specifying the IP Network Ring ID for the Source Routing Bridge

You can use the BCC to specify a ring ID for the backbone IP network to which 
the source routing bridge connects. You must specify the same IP network ring ID 
for each Nortel Network’s source routing bridge that connects to the network.

To specify the ring ID for the backbone IP network to which the source routing 
bridge connects, navigate to the global srb prompt (for example, box; srb) and 
enter:

ip-net-ring-id <id_number>

id_number is a hex value from 0x0 to 0xffe. The default value is 0x0. Assign the 
same value to all Nortel Network’s source routing bridges that border the IP 
network cloud. The IP network ring ID must be unique among any other group 
LAN IDs, ring IDs, or internal LAN IDs in the network.

For example, the following command assigns the IP network ring ID value 0x1 to 
the source routing bridge:

srb# ip-net-ring-id 0x1
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Chapter 5
Configuring Differentiated Services

Version 15.1.0.0

The following section describes a change to Configuring Differentiated Services.

Modifying RED Parameters

The following change is required to Table 6-1 in the “Modifying RED 
Parameters” section of the Configuring Differentiated Services book. 

The proper range of values for the id parameter is from 1 through 65535. The 
proper range is shown in the following table, which lists RED parameters that can 
be configured under dsqms-red, their values, and functions.

Parameter Values Function

id integer 1 through 
65535

Identifies the RED function. You cannot 
change this parameter.

min-threshold integer 0 through 
100 (default 20)

Indicates the queue size below which no 
packets are dropped by RED

max-threshold integer 1 through 
100 (default 80)

Indicates the queue size above which all pack-
ets are dropped by RED

first-order-const integer 0 through 
100 (default 1)

Specifies the first order constant used when 
calculating drop probability based on the aver-
age queue fraction, the queue size, and the 
min-threshold value

second-order-const integer 0 through 
1000 (default 10)

Specifies the second order constant used 
when calculating drop probability based on 
the average queue fraction, the queue size, 
and the min-threshold value
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Version 15.2.0.0

The following section corrects erroneous text in the description of the Priority 
parameter.

Priority Parameter

The description of the Priority parameter in Appendix A incorrectly states that the 
lower the number, the higher the priority. The description should state that the 
higher the number, the higher the priority. For example, a server with a priority of 
2 will be the active server before a server with a priority of 1.

Version 15.3.0.0

The following section is an amendment to Chapter 2, “Starting Differentiated 
Services” in Configuring Differentiated Services.

Implementation Notes

The following guidelines can help you successfully configure DSQMS on your 
router:

• You can configure DSQMS on these interfaces only: HSSI, MCT1, MCE1, 
T1/FT1, E1/FE1, and synchronous.

• If you enable flow fairness on a queue, you cannot configure that queue as a 
best-effort queue. For information about enabling flow fairness on a queue or 
designating the queue as best effort, see “Modifying a DSQMS Queue” in 
Configuring Differentiated Services.

• If you configure both weighted and priority queues on an interface, you may 
experience latency problems with the highest priority queues. To avoid such 
problems:

-- Set the DSQMS interface parameter dequeue-at-line-rate to enabled 
(the default value is disabled). See “Configuring DSQMS to Dequeue 
Packets at Line Rate” in Configuring Differentiated Services for 
instructions.

-- Ensure that the amount of high-priority traffic is not excessive in the 
highest priority queues.
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• If you implement RED for queue management instead of tail-drop (that is, 
you set the queue parameter drop-type to red and you associate the queue 
classifier with a RED function), the probability of dropping packets may 
adversely affect the latency requirements of some applications. Adjust the 
following parameters to achieve the required latency levels for the queue:

-- RED parameters min-threshold and max-threshold (see “Modifying 
RED Parameters” on page 3-1 for instructions).

-- Queue parameters average-queue-gain and idle-queue-loss-rate (see 
“Modifying a DSQMS Queue” in Configuring Differentiated Services for 
instructions).

Version 15.4.0.0

The following section is an amendment to Chapter 2, “Starting Differentiated 
Services” in Configuring Differentiated Services.

Implementation Notes

The following guidelines can help you successfully configure DSQMS on your 
router:

• You can configure DSQMS on these interfaces only: Ethernet, HSSI, MCT1, 
MCE1, T1/FT1, E1/FE1, and synchronous.

• If the Ethernet interface is connected to an external access device such as DSL 
or Cable modem, then Nortel Networks recommends considering policing on 
the ingress interface of the router by configuring traffic filters and also 
enabling dequeue-at-line-rate in DSQMS on the egress ethernet interface for 
traffic management.

• If you enable flow fairness on a queue, you cannot configure that queue as a 
best-effort queue. For information about enabling flow fairness on a queue or 
designating the queue as best effort, see “Modifying a DSQMS Queue” in 
Configuring Differentiated Services.

• If you configure both weighted and priority queues on an interface, you may 
experience latency problems with the highest priority queues. To avoid such 
problems:
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-- Set the DSQMS interface parameter dequeue-at-line-rate to enabled 
(the default value is disabled). See “Configuring DSQMS to Dequeue 
Packets at Line Rate” in Configuring Differentiated Services for 
instructions.

-- Ensure that the amount of high-priority traffic is not excessive in the 
highest priority queues.

• If you implement RED for queue management instead of tail-drop (that is, 
you set the queue parameter drop-type to red and you associate the queue 
classifier with a RED function), the probability of dropping packets may 
adversely affect the latency requirements of some applications. Adjust the 
following parameters to achieve the required latency levels for the queue:

-- RED parameters min-threshold and max-threshold (see “Modifying 
RED Parameters” on page 3-1 for instructions).

-- Queue parameters average-queue-gain and idle-queue-loss-rate (see 
“Modifying a DSQMS Queue” in Configuring Differentiated Services for 
instructions).
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Version 15.5.0.0

The following section is new to Chapter 4, “Customizing Differentiated Services” 
in Configuring Differentiated Services.

Differentiated Services Code Point (DSCP) Tagging for Router 
Generated Packets

Beginning with version 15.5.0.0, BayRS supports Differentiated Services Code 
Point (DSCP) tagging of internally generated router packets, such as OSPF Hello 
packets. This feature automatically provides Differentiated Services Queue 
Management System (DSQMS) queuing for all router generated packets based on 
the internal mapping between the DiffServ Code Point tag values and the DSQMS 
queues.

This Quality of Service (QoS) enhancement improves the QoS operational model 
of the platform by marking router generated packets and providing appropriate 
queuing treatment to marked traffic flows by the DSQMS. This QoS enhancement 
is based on the Nortel Networks Service Classes (NNSC) and provides default 
settings and behaviors for different categories of network traffic. The relationship 
between traffic categories, Nortel Networks Service Classes, and DiffServ code 
points (DSCPs) is shown in Table 5-1. 

Table 5-1. Relationship between Traffic Categories, NNSC, 
and DiffServ Code Points

Traffic Category NNSC DSCP

Critical Control Critical CS7

Network Network CS6

Interactive Premium EF, CS5

Platinum AF4x, CS4

Responsive Gold AF3x, CS3

Silver AF2x, CS2

Timely Bronze AF1x, CS1

Standard DF (CS0)
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Beginning with this QoS enhancement, the Differentiated Services Code Point 
(DSCP) tags (markings) assigned to BayRS router protocols are changed so that 
packets originating from the router are marked with the Differentiated Services 
Code Points shown in Table 5-2. These markings are not configurable; they are 
hard-coded and cannot be changed. 

Table 5-2. Mapping of BayRS Protocols and DiffServ Code Points

Traffic Category NNSC Network Protocol DSCP Scheduler

Critical Control Critical Frame Relay LMI, 
OSPF Hello, MOSPF 
Hello, LCP Echo 
Request, PPP LQR, 
COPS

CS7 ('111000') Strict Priority

Network Control Network OSPF, BGP, EGP, 
RIP, MOSPF, 
DVMRP, PIM-SM, 
VRRP

CS6 ('110000') Strict Priority

Responsive Silver IPEX, DLSw, 
RADIUS, SNMP, 
ICMP, DHCP, IGMP, 
NTP, RSVP, DNS, 
BOOTP

AF21 ('010010') User 
Configurable

Timely Standard FTP, TFTP, 
TELNET*, IKE, 
HTTP,
Non-IP traffic

* For additional information on Telnet tagging, see the following note about Telnet server packets.

DF (CS0)
('000000')

User 
Configurable

Note: Telnet server packets originating from the router in response to a Telnet 
client connection have the same DSCP tag as packets from the incoming 
Telnet connection. Telnet client packets originating from the router as a result 
of a router initiated Telnet connection remain unaffected; thus, they have a 
default tag of zero, which corresponds to the standard service class.
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Once marked with a DSCP tag, router generated packets are mapped to DSQMS 
queues based on the mapping scheme shown in Table 5-3. As the table indicates, 
critical and network control traffic is automatically directed to the two internal 
queues that have strict priority scheduling. 

You cannot change the mappings for the two internal queues. However, you can 
override the default mappings of the user configurable queues. For information 
about changing the mappings of the user configurable queues, see Configuring 
Differentiated Services. DSQMS configuration is supported by the BCC only.

Note: The DSCP in the IP headers of Internet Protocol Security (IPsec) 
packets remain the same as the DSCP of the original encapsulated IP packet. 
Therefore, IPsec packets are queued based on the DSCP of the original packets 
and are not subject to default queue mapping.

Note: The Timely category in Table 5-2 is redundant because all packets have 
a default DSCP value of CS0. However, it is included in the table to indicate 
which protocols will receive best effort treatment. Packets from all network 
protocols that are not included in the first three traffic categories in the table 
(Critical Control, Network Control, and Responsive) will be directed to the 
best effort queue, which corresponds to the Standard service class.

Note: It is recommended that you use BayRS traffic filters on untrusted 
ingress interfaces to limit the critical and network control traffic entering the 
box. Doing so minimizes congestion in the high priority internal queues.
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Table 5-3. Mapping of DSQMS Queues and DSCP

Number of 
DSQMS Queues 
Configured

Total Number of 
DSQMS Queues 
(excluding the FR 
Shaped Queue)

DSQMS 
Queue 
Number

Differentiated Services Code 
Point (DSCP)

1 3 INTQ1
INTQ2
Q1

CS7
CS6 
CS5, EF, AFxx, CS1-4, DF (CS0)

2 4 INTQ1
INTQ2
Q1
Q2

CS7
CS6
CS5, EF
AFxx, CS1-4, DF (CS0)

3 5 INTQ1
INTQ2
Q1
Q2
Q3

CS7
CS6
CS5, EF 
AF4x, CS4
AF3x, AF2x, AF1x, CS3, CS2, 
CS1, DF (CS0)

4 6 INTQ1
INTQ2
Q1
Q2
Q3
Q4

CS7
CS6
CS5, EF
AF4x, CS4
AF3x, CS3
AF2x, CS2, AF1x, CS1, DF, (CS0)

5 7 INTQ1
INTQ2
Q1
Q2
Q3
Q4
Q5

CS7
CS6
CS5, EF
AF4x, CS4
AF3x, CS3
AF2x, CS2
AF1x, CS1, DF (CS0)
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To support this QoS enhancement, BCC show command statistics output is 
expanded to provide additional information, as described in the next section.

BCC show Command Enhancement

The following information supersedes that provided in Appendix C, “Using BCC 
show Commands,” in Configuring Differentiated Services. 

show dsqms queues stats

The BCC show dsqms queues stats command displays a table of DSQMS 
queues, or more specific information based on any filter argument entered, with a 
subset of information from the show dsqms queues detail command. This 
command displays statistics for the DSQMS configured queues and the reserved 
DSQMS queues (two Internal queues and the Frame Relay (FR) Shaped queue). It 
is the only command that provides any information about the DSQMS reserved 
queues.

This command allows the following command filter flag and argument:

6 8 INTQ1
INTQ2
Q1
Q2
Q3
Q4
Q5
Q6

CS7
CS6
CS5, EF
AF4x, CS4
AF3x, CS3
AF2x, CS2
AF1x, CS1
DF (CS0)

Note: INTQ1 and INTQ2 are internal queues. EF, CS5, AF4x, CS4, AF3x, and CS3 are 
DSCPs associated with traffic types that are not router generated. This QoS enhancement 
deals only with three DSCP tag values: CS7, CS6, and AF21. The other tag values are 
included in the table as a reference for facilitating configuration recommendations.

-circuit <circuit_no.> Displays information about queues on the specified circuit 
only.

Table 5-3. Mapping of DSQMS Queues and DSCP (continued)

Number of 
DSQMS Queues 
Configured

Total Number of 
DSQMS Queues 
(excluding the FR 
Shaped Queue)

DSQMS 
Queue 
Number

Differentiated Services Code 
Point (DSCP)
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The output now includes the new DSQMS reserved queue types added for version 
15.5.0.0 and provides the following information:

The DSQMS reserved queue types are as follows:

• Internal Queue 1 (IntQ1)

• Internal Queue 2 (IntQ2)

• FrameRelay Shaped Queue (FR ShQ)

Interoperability of Protocol Prioritization (Priority Queuing) and 
DSQMS

There is a common misconception that Protocol Prioritization (priority queuing) 
and DSQMS cannot co-exist. On the contrary, these two features can be 
configured at the same time. In fact, there are situations when DSQMS is 
configured in which Protocol Prioritization also must be configured, such as in the 
case of prioritizing Frame Relay (FR) Local Management Interface (LMI) traffic 
into IntQ1.The same situation also applies when prioritizing PPP Link Quality 
Report (LQR) packets and Link Control Protocol (LCP) echo requests.

The inter-operability of these two features can be summarized as follows:

• DSQMS operates at the driver level only.

• When Frame Relay (FR) is configured, Protocol Prioritization operates at the 
driver level as well as at the FR level.

Cct Name of the circuit

Id/Type Identification number of configured queue or type of reserved 
queue 

Pkt Count Number of packets queued

Byte Count Number of octets queued

Xmit Pkts Number of packets transmitted

Xmit Bytes Number of octets transmitted

Dropped Pkts Number of dropped packets

Dropped Bytes Number of dropped octets
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• When both Protocol Prioritization and DSQMS are configured, at the driver 
level DSQMS always takes precedence. This means that such a configuration 
is inconsequential as far as Protocol Prioritization is concerned because at the 
driver level, DSQMS will be running.

• When both Protocol Prioritization and DSQMS are configured, at the FR level 
only Protocol Prioritization operates (because DSQMS operates only at the 
driver level). BayRS code (even before DSCP Tagging feature) tags FR LMI 
as interrupt traffic only if Protocol Prioritization is configured. So, the purpose 
of Protocol Prioritization configuration for LMI is only to tag packets (in the 
FR code) so they can be identified later (in the driver code). When a tagged 
LMI packet comes to the driver, the following occurs:

• When DSQMS is not configured, Protocol Prioritization operates at the 
driver level. In this case, Protocol Prioritization identifies the tag and puts 
the LMI traffic into the Interrupt Queue.

• When DSQMS is configured, it takes precedence over Protocol 
Prioritization. In this case, DSQMS identifies the tag and puts the LMI 
traffic into Internal Queue 1 (IntQ1).
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Chapter 6
Configuring Ethernet, FDDI, and Token Ring

Services

Version 15.4.0.0

The following section is new to Chapter 2 of Configuring Ethernet, FDDI, and 
Token Ring Services.

The sections “Router Processing of Tagged Frames,” “Implementation 
Considerations,” “Adding a Tagged Circuit to an Unconfigured 10BASE-T or 
100BASE-T Interface,” and “Adding a Tagged Circuit to an Existing 10BASE-T 
or 100BASE-T Interface” contain amendments to Chapter 5 of Configuring 
Ethernet, FDDI, and Token Ring Services.

Specifying the DSQMS Line Speed

You specify the DSQMS line speed using the dsqms-line-speed parameter. You 
access this parameter by navigating to the ethernet prompt (for example, box; 
ethernet 2/1) and entering the following command

dsqms-line-speed <value>

value specifies the line speed (in bits per second) for the DSQMS client. The 
default is 1250000 (1.25Mbps). 

In network configurations where the Ethernet interface is connected to an external 
access device such as DSL or a Cable modem, the dsqms-line-speed parameter 
can be used in conjunction with dequeue-at-line rate parameter enabled on the 
egress interface and traffic policing on the ingress interface for traffic 
management.
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For example, to change the line speed to 10Mbps:

ethernet/2/1# dsqms-line-speed 10000000
ethernet/2/1# 

Router Processing of Tagged Frames

802.1Q tagging is supported on 10BASE-T and 100BASE-T interfaces that 
connect the Nortel Networks router to an 802.1Q-compliant switch or routing 
switch. With 802.1Q tagging enabled, the physical connection between the router 
and the adjacent device supports multiple virtual connections.

The number of connections is equal to the number of virtual connections plus a 
default physical connection that provides transit services for other non-VLAN 
traffic that may be received from or forwarded to the adjacent device.

Upon receipt of a frame across a virtual connection, a circuit manager strips the 
four bytes of 802.1Q header information and directs a now standard Ethernet 
frame to a connection-specific routing process. The routing process consults its 
forwarding table and, in turn, directs the frame to a circuit manager handling the 
next-hop connection. If that connection is a non-tagged, non-virtual connection, 
processing is completed as for any other standard Ethernet frame.

However, if the next-hop connection is a tagged, virtual connection, the circuit 
manager inserts the four bytes of 802.1Q header information that identify that 
VLAN into the standard Ethernet header. After performing the 802.1Q 
encapsulation, the circuit manager forwards the frame across the virtual 
connection toward the destination VLAN.

Implementation Considerations

Before you configure 802.1Q tagging on a router, note the following 
considerations:

• 802.1Q tagging is supported on 10BASE-T and 100BASE-T interfaces; it is 
not supported on other LAN interfaces.

• 802.1Q tagging cannot be used to extend a VLAN across multiple devices.

• The VLAN type (port-based, protocol-based, address-based, and so on) is 
ignored by the router.
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• The following table shows the modules that support 802.1Q tagging:

Table 6-1. Supported Modules for 802.1Q Tagging

Platform Ethernet Interface Type

Passport 2430 10/100 Base Unit

Passport 2430 Second Ethernet Module

ARN Ethernet Base Unit

ARN ARN -48VDC Ethernet Base Unit

ARN 10/100-TX UTP Base Unit

ARN Ethernet Expansion Module

ARN Ethernet and Tri-Serial Expansion Module

ARN Ethernet and 7-Serial Expansion Module

Passport 5430 Dual 10/100 Ethernet Base Unit

ASN Dual Ethernet Net Module

BLN/BCN Quad Port Ethernet FRE2-060

BLN/BCN Quad Port Ethernet – High Speed Filters FRE2-060

BLN/BCN Dual Ethernet/Dual Sync – No Filters FRE2-060 

BLN/BCN Dual Ethernet/Dual Sync – Max. Filters FRE2-060

BLN/BCN Ethernet Sync/Async No Filters (ESAF) FRE2-060E

BLN/BCN Ethernet Sync/Async With Filters (ESAFNF) FRE2-060E

BLN/BCN Quad Port 10/100Base-TX with FRE4-PPC
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Adding a Tagged Circuit to an Unconfigured 10BASE-T or 100BASE-T 
Interface

The following procedure describes how to add an 802.1Q tagged circuit to a 
previously unconfigured 10BASE-T or 100BASE-T interface. The procedure 
assumes that you are configuring the 802.1Q tagged circuit for IP routing. To 
enable other routing protocols on an 802.1Q tagged circuit, see the appropriate 
guide for that protocol. 

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on a 100BASE-T connector.

The Add Circuit window opens.

2. Click on OK. The Select Protocols window opens.

3. Choose VLAN, then click on OK. The Edit VLAN Interface Parameters 
window opens.

4. Click on Add. The TAG1Q Parameters window opens.

5. Set the following parameters:
• VLAN Name
• Global VLAN Id
Click on Help to see the parameter 
descriptions.

6. Click on OK. The Edit VLAN Interface Parameters 
window opens. Note that 802.1Q tagged 
circuits are displayed with a Vn extension.

7. Select the 802.1Q tagged circuit that you 
are adding. Set the Protocol Type (hex) 
parameter. Retain the default value for 
connection to Nortel Networks 
802.1Q-enabled devices.

8. Click on Apply and Done. You return to the Configuration Manager 
window.

To add IP routing to the 802.1Q tagged circuit:

9. Choose Circuits.

10. Choose Edit Circuits. The Circuit List window opens.

11. Select the 802.1Q tagged circuit. 
Note that 802.1Q tagged circuits are 
displayed with a Vn extension.
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Adding a Tagged Circuit to an Existing 10BASE-T or 100BASE-T 
Interface

To add an 802.1Q tagged circuit to an existing 10BASE-T or 100BASE-T 
interface, complete the following tasks: 

12. Click on Edit. The Circuit Definition window opens.

13. Choose Protocols.

14. Choose Add/Delete. The Select Protocols window opens.

15. Select IP and click on OK. The IP Configuration window opens.

16. Enter an IP address and subnet mask and 
click on OK.

The Circuit Definition window opens.

17. Choose File.

18. Choose Exit. The Circuit List window opens.

19. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on a 10BASE-T or 100BASE-T 
connector.

The Edit Connector window opens.

2. Click on Edit Circuit. The Circuit Definition window opens.

3. Choose Protocols. The Protocols menu opens.

4. Choose Add/Delete. The Select Protocols window opens.

5. Choose VLAN, then click on OK. The Edit VLAN Interface Parameters 
window opens.

6. Click on Add. The TAG1Q Parameters window opens.

7. Set the following parameters:
• VLAN Name
• Global VLAN Id
Click on Help to see the parameter 
descriptions.

Site Manager Procedure (continued)

You do this System responds
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8. Click on OK. The Edit VLAN Interface Parameters 
window opens. Note that 802.1Q tagged 
circuits are displayed with a Vn extension.

9. Select the 802.1Q tagged circuit that you 
are adding. Set the Protocol Type (hex) 
parameter. Retain the default value for 
connection to Nortel Networks 
802.1Q-enabled devices.

10. Click on Apply and Done. You return to the Configuration Manager 
window.

To add IP routing to the 802.1Q tagged circuit:

11. Choose Circuits.

12. Choose Edit Circuits. The Circuit List window opens.

13. Select the 802.1Q tagged circuit. 
Note that 802.1Q tagged circuits are 
displayed with a Vn extension.

14. Click on Edit. The Circuit Definition window opens.

15. Choose Protocols.

16. Choose Add/Delete. The Select Protocols window opens.

17. Select IP and click on OK. The IP Configuration window opens.

18. Enter an IP address and subnet mask and 
click on OK.

The Circuit Definition window opens.

19. Choose File.

20. Choose Exit. The Circuit List window opens.

21. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Version 15.5.0.0

The following implementation note is being added to the BayRS Version 15.5.0.0 
Documentation Change Notice since it became available after publication of the 
15.4.0.0 documentation.

Implementation Note

When you configure VLAN tagging on an ARN 10MB Ethernet Base Module, the 
MTU for the Ethernet interface is set to 1518 bytes for the packets on this line. 
Although the ARN 10MB Ethernet Base Module supports tagged packets, it does 
not support 802.1Q tagged frames that are larger than 1518 bytes (1514 bytes plus 
the 4-byte tag). 

However, there are other Ethernet interfaces (such as the Ethernet and Tri-Serial 
Expansion Module and the 10/100-TX UTP Base Module) that have an MTU of 
1522 bytes and, consequently, do support the maximum size tagged packet (1518 
bytes plus the 4-byte tag). 

Because of differences in the MTU size supported, when you configure VLAN 
tagging on an ARN 10MB Ethernet Base Module, you must make sure that no 
other tagged hosts on the LAN that are attached to the 10BT motherboard 
Ethernet port have MTUs greater than 1518 bytes. If they do, you must reset their 
respective MTUs to 1518 bytes so they can interoperate properly with the ARN 
10MB Ethernet Base Module.
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Chapter 7
Configuring Frame Relay Services

Version 15.1.0.0

The following changes are required to the Configuring Frame Relay Services 
book.

A new frame relay parameter, Bw Threshold, has been added to the PVC List for 
Services window in Site Manager. The Bw Threshold parameter works in 
conjunction with the Committed Burst, Excess Burst, and Throughput parameters 
to shape traffic. 

The following sections update the Site Manager procedure within the “Using 
Traffic Shaping” section in Chapter 4 and adds the parameter description to 
Appendix A: “Site Manager Parameters.”

Using Traffic Shaping – Site Manager

To enable traffic shaping, complete the following tasks using Site Manager:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on a port configured for frame relay.

The Edit Connector window opens.

2. Click on Edit Circuit. The Frame Relay Circuit Definition 
window opens.

3. Click on Services. The Frame Relay Service List window 
opens.

(continued)
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Version 15.2.0.0

The following section describes a limitation that was omitted from Configuring 
Frame Relay Services.

Deleting PVCs from Service Records

The section “Deleting PVCs from Service Records” in Configuring Frame Relay 
Services should include the statement that Site Manager does not allow users to 
delete or move the last PVC in the only non-default service record. If you want to 
delete or move the last PVC, you must remove the entire service record.

4. Select the appropriate service record and 
click on PVCs.

The FR PVC List for Service window 
opens.

5. Click on a PVC that you want to configure 
for traffic shaping. 

6. Set the following parameters:
• Committed Burst
• Excess Burst
• Throughput
• Bw Threshold
Click on Help or see the parameter
description in “Frame Relay PVC
Parameter” on page A-13.

7. Click on Done. You return to the Frame Relay Service 
List window.

8. Click on Done. You return to the Frame Relay Circuit 
Definition window.

9. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Chapter 8
Configuring IP, ARP, RIP, RARP, and OSPF

Services

Version 15.3.0.0

The following section is new to Chapter 1, “IP Concepts, Terminology, and 
Features” in Configuring IP, ARP, RIP, RARP, and OSPF Services.

RFC826 Support

BayRS now supports RFC826: An Ethernet Address Resolution Protocol. 
According to RFC826, when a router interface receives an ARP request or reply, 
it checks the source IP address to make sure that it is valid and the router’s 
translation table for the destination IP and MAC address pair. If the saved MAC 
address in the table is different from the reported MAC address, the router 
replaces the old MAC address with the new one. The interface then checks for the 
message type (request or reply). If the router cannot find the MAC address in the 
translation table, it discards the message. 
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Version 15.4.0.0

The following sections are amendments to Configuring IP, ARP, RIP, RARP, and 
OSPF Services.

Defining BGP Peers for BGP, OSPF, and RIP Announce Policies

When defining a BGP peer for an announce policy, the peer must be identified by 
its BGP router ID. To verify the router ID of the BGP peer, on the peer router, 
check the configured value for the Site Manager BGP Global parameter, BGP 
Identifier, or the BCC BGP parameter, router-id. For information about supplying 
a router ID for a BGP router, see Configuring IP Exterior Gateway Protocols 
(BGP and EGP).

Importing RIP updates

You can now select whether the router imports RIP-1 updates only, RIP-2 updates 
only, or both RIP-1 and RIP-2 updates from a neighbor router. The following 
procedures describe how to configure this feature using the BCC and Site 
Manager.

Using the BCC

To have RIP-1 accept both RIP-1 broadcast and RIP-2 multicast packets (and 
have RIP-2 always use multicast for transmitting updates), go to the RIP interface 
prompt (for example, box; eth 2/2; ip/10.1.1.2/255.255.0.0; rip) and enter:

rip1-comp disable

For example, to disable rip1-comp, enter:

rip/10.1.1.2# rip1-comp disable
rip/10.1.1.2# 

To have RIP-1 accept RIP-1 broadcast and RIP-2 broadcast packets only (RIP-1 
will not accept RIP-2 multicast packets) and have RIP-2 broadcast the packets, 
making it compatible with RIP-1, go to the RIP interface prompt (for example, 
box; eth 2/2; ip/10.1.1.2/255.255.0.0; rip) and enter:

rip1-comp enable
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For example, to enable rip1-comp, enter:

rip/10.1.1.2# rip1-comp enable
rip/10.1.1.2# 

Using Site Manager

To have RIP-1 accept both RIP-1 broadcast and RIP-2 multicast packets (and 
have RIP-2 always use multicast for transmitting updates), or to have RIP-1 
accept RIP-1 and RIP-2 broadcast packets only, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose RIP Interfaces. The IP RIP Interface Configuration 
window opens. 

4. Click on the RIP interface that you want to 
edit.

The parameter values for that interface 
appear in the IP RIP Interface 
Configuration window. 

5. Set the Rip Compatible parameter. Click 
on Help or see the parameter description 
on page A-30.

6. Click on Apply, and then click on Done. You return to the Configuration Manager 
window.
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MIB Object IDs

Please note the changes to the following MIB object IDs (OIDs): 

Note: To get to the following parameters, use the path 
Configuration Manager > Protocols > IP > Interfaces or Configuration 
Manager > Protocols > IP > Global

Site Manager 
Parameter Name Old OID New OID

Subnet Mask 1.3.6.1.4.1.18.3.5.3.2.1.4.1.6 1.3.6.1.4.1.18.3.5.3.2.1.24.1.6

UnNumbered Assoc 
Addr

1.3.6.1.4.1.18.3.5.3.2.1.4.1.110 1.3.6.1.4.1.18.3.5.3.2.1.24.1.47

Mask 1.3.6.1.4.1.18.3.5.3.2.1.4.1.6 1.3.6.1.4.1.18.3.5.3.2.1.24.1.6

Broadcast Address 1.3.6.1.4.1.18.3.5.3.2.1.4.1.9 1.3.6.1.4.1.18.3.5.3.2.1.24.1.8

Cost 1.3.6.1.4.1.18.3.5.3.2.1.4.1.8 1.3.6.1.4.1.18.3.5.3.2.1.24.1.7

Host Cache 1.3.6.1.4.1.18.3.5.3.2.1.24.1.18 1.3.6.1.4.1.18.3.5.3.2.1.24.1.17

TR End Station 1.3.6.1.4.1.18.3.5.3.2.1.4.1.64 1.3.6.1.4.1.18.3.5.3.2.1.24.1.19

TR End Station
ARP Type

1.3.6.1.4.1.18.3.5.3.2.1.4.1.127 1.3.6.1.4.1.18.3.5.3.2.1.24.1.56

Redirect 1.3.6.1.4.1.18.3.5.3.2.1.4.1.70 1.3.6.1.4.1.18.3.5.3.2.1.24.1.25

Ethernet Arp Encaps 1.3.6.1.4.1.18.3.5.3.2.1.4.1.71 1.3.6.1.4.1.18.3.5.3.2.1.24.1.26

SMDS Group 
Address

1.3.6.1.4.1.18.3.5.3.2.1.4.1.65 1.3.6.1.4.1.18.3.5.3.2.1.24.1.20

SMDS Arp Request 
Address

1.3.6.1.4.1.18.3.5.3.2.1.4.1.66 1.3.6.1.4.1.18.3.5.3.2.1.24.1.21

WAN Broadcast 
(was FRB 
Broadcast)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.67 1.3.6.1.4.1.18.3.5.3.2.1.24.1.22

WAN Multicast #1 
(was FRM Cast 1 
DLCI)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.68 1.3.6.1.4.1.18.3.5.3.2.1.24.1.23

WAN Multicast #2 
(was FRM Cast 2 
DLCI)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.69 1.3.6.1.4.1.18.3.5.3.2.1.24.1.24
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Slot Mask 1.3.6.1.4.1.18.3.5.3.2.1.4.1.75 1.3.6.1.4.1.18.3.5.3.2.1.24.1.27

Max Forwarding 
Table Size (was 
Forward Cache Size)

1.3.6.1.4.1.18.3.5.3.2.1.4.1.104 1.3.6.1.4.1.18.3.5.3.2.1.24.1.46

Unnumbered 
Associated Alternate

1.3.6.1.4.1.18.3.5.3.2.1.4.1.111 1.3.6.1.4.1.18.3.5.3.2.1.24.1.47

IP OSPF Maximum 
Path

1.3.6.1.4.1.18.3.5.3.2.3.1.18 1.3.6.1.4.1.18.3.5.3.2.1.1.21

Site Manager 
Parameter Name Old OID New OID
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Version 15.5.0.0

The following section is an addition to Chapter 3, “Configuring and Customizing 
IP” in Configuring IP, ARP, RIP, RARP, and OSPF Services:

Enabling and Disabling Unique Identifiers for ICMP Echo Requests.

The following section is an addition to Chapter 6, “Configuring and Customizing 
OSPF” in Configuring IP, ARP, RIP, RARP, and OSPF Services:

RFC 3101 Forwarding Address Compatibility for OSPF NSSA.

Enabling and Disabling Unique Identifiers for ICMP Echo Requests

Beginning with BayRS version 15.5.0.0, you can send an ICMP echo request with 
a unique identifier. Utilizing this enhancement can help with problems pinging 
from a BayRS router to another network point through third-party Network 
Address Translation (NAT) routers that require a unique identifier for each ICMP 
echo request message.

A new global IP MIB, wfIpBaseIcmpEchoUniIdEnable, enables and disables this 
feature. When this feature is enabled, a unique identifier is added to each ICMP 
echo request message. 

This enhancement to ICMP echo requests is disabled by default. You can use the 
BCC or Site Manager to enable and disable this feature as required.

Using the BCC

To enable or disable unique identifiers for ICMP echo requests, go to the global IP 
prompt (for example, box; ip) and enter:

icmp-echo-request-unique-id <state>

state is one of the following:

disable (default)
enable

For example, the following command enables unique identifiers for ICMP echo 
requests:

ip# icmp-echo-request-unique-id enable
ip#
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Using Site Manager

To enable or disable unique identifiers for ICMP echo requests, complete the 
following tasks:

RFC 3101 Forwarding Address Compatibility for OSPF NSSA

Beginning with BayRS version 15.5.0.0, you can configure the autonomous 
system external (ASE) forwarding address of the type 7 not-so-stubby-area 
(NSSA) link state database (LSDB) to any valid IP address on the network. The 
reason for this improvement is that in BayRS version 15.5.0.0, the Open Shortest 
Path First (OSPF) NSSA is enhanced to comply with section 2.5, “Calculating 
Type-7 AS External Routes,” and some parts of Appendix F, “Differences from 
RFC 1587,” of RFC 3101. Full implementation of RFC 3101 is planned for a 
future release.

Using the enhanced functionality in version 15.5.0.0, a network administrator now 
has the option to import summary route advertisements into the NSSAs. If the 
option to import summary advertisements is not enabled, then the NSSA 
autonomous system (AS) boundary router (ASBR) generates a default summary 
route for the NSSA that enables inter-area routing from the NSSA to the other 
areas. In addition to this new option, an administrator now also can set the 
autonomous system external (ASE) forwarding address of the AS external routes 
that are generated in the NSSA. 

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP.

3. Choose Global. The Edit IP Global Parameters window 
opens. 

4. Set the Icmp Echo Request Unique Id 
parameter. Click on Help or see the 
parameter description on page A-18.

5. Click on OK. You return to the Configuration Manager 
window.
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In prior implementations of OSPF NSSA, which were based on RFC 1587, Nortel 
routers selected as the ASE forwarding address, the lowest IP address of the 
interfaces that were up at that time on the router. However, this implementation 
sometimes caused convergence problems when the interface with the lowest IP 
address went down and the next available interface IP address was used as the 
ASE forwarding address. 

Using the version 15.5.0.0 functionality, a network administrator now can specify 
the IP address to be used as the ASE forwarding address, thus enabling him or her 
to specify the IP address of an interface that is known to stay up all the time. To 
ensure maximum up time, it is recommended that you use the IP address of the 
circuitless IP interface on the router as the ASE forwarding address.

To use this functionality, you must configure two new parameters as described in 
the following sections:

• Enabling and Disabling RFC 3101 Forwarding Address Compatibility

• Configuring the Not-So-Stubby Area (NSSA) Forwarding Address

When you start OSPF on the router, RFC 3101 compatibility is disabled by 
default. When RFC 3101 compatibility is disabled, any configured ASE 
forwarding address is ignored.

Enabling and Disabling RFC 3101 Forwarding Address Compatibility

You can use the BCC or Site Manager to enable and disable RFC 3101 
compatibility on the router. 

Using the BCC

To enable or disable RFC 3101 compatibility on the router, go to the global OSPF 
prompt (for example, box; ip; ospf) and enter:

rfc3101-fwd-addr-compatibility <state>

state is one of the following:

disable (default)
enable

For example, the following command enables RFC 3101 compatibility on the 
router:
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ospf# rfc3101-fwd-addr-compatibility enable
ospf#

Using Site Manager

To enable or disable RFC 3101 compatibility on the router, complete the 
following tasks:

Configuring the Not-So-Stubby Area (NSSA) Forwarding Address

Once you enable RFC 3101 compatibility on the router, you must specify the IP 
address to be used as the new ASE forwarding address for the NSSA. You can 
specify this address using the BCC or Site Manager.

Using the BCC

Before you can configure a not-so-stubby area (NSSA) forwarding address, you 
first must enable the nssa-default-originate parameter.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose OSPF/MOSPF. The OSPF/MOSPF menu opens.

4. Choose Global. The Edit OSPF Global Parameters 
window opens. 

5. Set the Rfc 3101 Compatibility Enable 
parameter. Click on Help or see the 
parameter description on page A-22.

The value you chose appears in the Rfc 
3101 Compatibility Enable field. 

6. Click on OK. You return to the Configuration Manager 
window.

Note: To configure this parameter, you first must enable the origination of a 
type 7 default route by the AS boundary router.
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To configure a not-so-stubby area (NSSA) forwarding address, go to the area 
prompt (for example, box; ip; ospf; area/0.0.0.3) and enter: 

nssa-route-fwd-addr <value>

value is any valid IP address in the network.

Using Site Manager

Before you can configure a not-so-stubby area (NSSA) forwarding address, you 
first must set the NSSA Originate Def Route parameter to Enable.

To configure a not-so-stubby area (NSSA) forwarding address, complete the 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose OSPF/MOSPF. The OSPF/MOSPF menu opens.

4. Choose Areas. The OSPF Areas window opens. 

5. Click on the area that you want to edit. The parameter values for that area 
appear in the OSPF Areas window. 

6. Set the NSSA Forward Address 
parameter. Click on Help or see the 
parameter descriptions beginning on page 
A-22.

Note: To use this parameter, you first 
must set the NSSA Originate Def Route 
parameter to Enable.

7. Click on Apply, and then click on Done. You return to the Configuration Manager 
window.
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Chapter 9
Configuring IP Multicasting

and Multimedia Services

Version 15.2.0.0

The following section is new to Configuring IP Multicasting and Multimedia 
Services.

Configuring a PIM Bootstrap Border Router

You can define a router as a PIM bootstrap border router (PBBR) by specifying at 
least one of its interfaces as a PIM bootstrap border interface (PBBI). A bootstrap 
border router prevents a bootstrap message that is received from one side of a 
border router from being passed to the other side of the router. The bootstrap 
border router allows you to create two or more PIM bootstrap domains in one PIM 
domain so that the rendezvous point (RP) information kept in the routers can be 
different.

To specify a PIM bootstrap router as a border router, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose PIM. The PIM menu opens. 

(continued)
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4. Choose Interface. The PIM Interface Parameters window 
opens.

5. Set the Bootstrap Border parameter. 
Click on Help or see the parameter 
description in “IP PIM Parameter” on page 
A-20.

6. Click on OK. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Chapter 10
Configuring RADIUS

Version 15.2.0.0

The following sections are amendments to Configuring RADIUS:

Configuring a RADIUS Client Using Site Manager

With earlier versions of Site Manager, you configured RADIUS only on link 
modules that had synchronous interfaces. With Version 15.2.0.0, you can use Site 
Manager to configure RADIUS on any link module, including Quad Ethernet, 
FDDI, and token ring. Consequently, Site Manager no longer automatically 
configures a demand circuit group when you use it to configure a RADIUS client. 

Topic Page

Configuring a RADIUS Client Using Site Manager 10-1

Modifying Router Access Using the BCC or Site Manager 10-2

Using SecurID for RADIUS Authentication 10-5
314470-15.5 Rev 00 10-1



BayRS Version 15.5.0.0 Document Change Notice
To enable RADIUS on a router slot and configure the RADIUS client:

Modifying Router Access Using the BCC or Site Manager

With RADIUS, you can modify access to the router using the user/manager lock 
and the login accounting feature.

User/Manager Lock

With earlier versions of BayRS, you enabled the user/manager lock using the 
Technician Interface only. You can now enable it using the BCC or Site Manager. 
The lock is disabled by default, allowing access by all users with the user or 
manager profile, and also by individual users with a unique profile. You enable the 
lock when both the RADIUS client and server are available. You disable the lock 
if the RADIUS server is not available, allowing the user to log in with the manager 
or user profile.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window,
select Protocols > Global Protocols >
RADIUS > Create RADIUS.

The RADIUS Client Parameters window
opens. The window lists the slots that
already have RADIUS configured on
them.

2. Click on Add. For multislot routers, the RADIUS Slot
Selection window opens. For single-slot
routers, the RADIUS Client Parameters
window opens. Go to step 4.

3. Enter the slot number on which you want
to configure RADIUS and click on OK.

The RADIUS Client Parameters window
opens.

4. Set the following parameters:
• Authentication
• Accounting
• Client IP Address
• Debug Message Level
Click on Help or see the parameter 
descriptions beginning on page A-27.

5. Click on OK. You return to the RADIUS Client 
Parameters window.
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When you enable the user/manager lock and a RADIUS server is unavailable for
authentication, the router automatically disables the user/manager lock. When the
RADIUS server becomes available, the router automatically enables the
user/manager lock.

Using the BCC

To restrict access to individual users only, navigate to the access prompt (for 
example, box; access) and enter:

user-manager-lock enable

To allow access by all users with the manager or user profile, in addition to users 
with a unique profile, navigate to the access prompt (for example, box; access) 
and enter:

user-manager-lock disable

Using Site Manager

To restrict access to individual users only, complete the following tasks:

Note: Be sure to configure RADIUS and assign the appropriate access to
individuals with unique profiles before you enable the user/manager lock;
otherwise you may lock out system managers from the router.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window,
choose Protocols > Global Protocols >
RADIUS > Access Control.

The RADIUS Access Control window
opens.

2. Set the User Manager Lock parameter to
Enable. For more information, click on
Help or see the parameter descriptions
beginning on page A-27.

3. Click on OK. You return to the Configuration Manager 
window.
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Login Accounting

BayRS RADIUS accounting is now supported for console and Telnet router 
logins. The following sections, new to Configuring RADIUS, describe the 
functionality that was added to support this feature.

You determine whether a console or Telnet login session should allow RADIUS 
accounting messages to be sent to the RADIUS server by enabling or disabling 
RADIUS accounting access to the server.

Using the BCC

To allow RADIUS accounting messages to be sent to the RADIUS server,
navigate to the access prompt (for example, box; access) and enter:

user-access-radius-account-enable enable

To prevent RADIUS accounting messages from being sent to the RADIUS server,
navigate to the access prompt (for example, box; access) and enter:

user-access-radius-account-enable disable

Note: If you enable login accounting, and the RADIUS server becomes
unavailable, the value for the user-access-radius-account-enable parameter
is automatically set to “serverwait.” When the RADIUS server becomes
available again, the value reverts to enabled.
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Using Site Manager

To allow RADIUS accounting messages to be sent to the RADIUS server,
complete the following tasks:

Using SecurID for RADIUS Authentication

This section in Configuring RADIUS incorrectly states that Nortel Networks 
implements SecurID on ARN* routers only. Nortel Networks implements 
SecurID on all router platforms that operate as RADIUS clients.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window,
choose Protocols > Global Protocols >
RADIUS > Access Control.

The RADIUS Access Control window
opens.

2. Set the Login Accounting parameter to
Enable. For more information, click on
Help or see the parameter descriptions
beginning in page A-27.

3. Click on OK. You return to the Configuration Manager 
window.
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Chapter 11
Using the Technician Interface Scripts

Version 15.1.0.0

The Technician Interface is a command-line interface that Nortel Networks 
support technicians can use to troubleshoot and configure Nortel Networks 
devices.

The following section is an amendment to Using the Technician Interface Scripts:

Using Scripts and Aliases to Dynamically Configure a Router

Use of rapid-fire scripts or aliases to dynamically set a router’s configuration via 
the MIBs can put the router into a corrupted state and cause connectivity issues. 
When you use the Technician Interface to launch scripts or aliases to configure the 
router be sure to include pauses (one to two seconds) to allow sufficient time for 
the router to make the required changes to the MIBs.
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Chapter 12
Using the Technician Interface Software

Version 15.1.0.0

The Technician Interface is a command-line interface that Nortel Networks 
support technicians can use to troubleshoot and configure Nortel Networks 
devices.

The following sections are amendments to Using the Technician Interface 
Software:

Diagnostics On/Off Option for ARN, Passport 2340, and Passport 5430

For ARN, Passport 2430 and Passport 5430 platforms only, the Technician 
Interface diags command supports an option to enable or disable diagnostics, 
effective the next time you cycle power on the router. Disabling the diagnostics 
results in a faster boot time, but leaves the hardware components unverified. The 
syntax for this option is as follows:

diags [- on|off] [<slot_id>]

Setting Default Route Cost Using the Technician Interface

When the routing table does not contain the route to a particular destination 
address, the router looks for a default route. As it does for any other route, the 
routing table either acquires the default route dynamically (through a routing 
protocol), or you can enter the default route statically.
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You can use the Technician Interface to set the wfRipIntfDefaultRouteCost (RIP 
default route cost) MIB attribute. This attribute interacts with the Site Manager 
parameter Default Route Supply or BCC parameter default-supply in one of two 
ways:

• If you select Enable for Default Route Supply or default-supply, RIP 
advertises the default route cost you set for wfRipIntfDefaultRouteCost 
attribute plus the default route learned from the network.

• If you select Generate for Default Route Supply or default-supply, RIP 
advertises the default route cost you set for wfRipIntfDefaultRouteCost.

For additional information, see “Supplying a Default Route on an Interface” in 
Configuring IP, ARP, RARP, RIP and OSPF Services. 

With the Technician Interface, enter the following commands to set the 
wfRipIntfDefaultRouteCost (RIP default route cost) attribute:

set wfRipIntfDefaultRouteCost <value>

value is any integer from 0 through 15. The default value is 1.

commit

save config <vol>: <filename>

You must have Manager access to issue a set command. The commit command 
causes the changes you made to the configuration to take effect in active memory, 
but not in flash memory. The save config command saves changes to a 
configuration file (config) and flash volume on the router.

Version 15.4.0.0

The following section describes how to enable the daylight savings time feature 
for the router using the Technician Interface.

Setting Daylight Savings Time Using the Technician Interface

Daylight savings time is the time during which clocks are set one hour or more 
ahead of standard time to provide more daylight at the end of the working day 
during late spring, summer, and early fall. In the United States, we set the clock 
ahead one hour at 2:00 am on the first Sunday in April and set the clock back one 
hour at 2:00 am on the last Sunday in October. 
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When you enable the daylight savings time feature using the Technician Interface, 
the router’s internal clock automatically sets itself one hour ahead at 2:00 am on 
the first Sunday in April and sets itself back one hour at 2:00 am on the last 
Sunday in October. Currently, only four time zones are supported: Eastern, 
Central, Mountain, and Pacific.

To enable the daylight savings time feature, enter the following command at the 
Technician Interface prompt:

set wfSys.wfSysDaylightSaving.0 1; commit

Removing the Technician Interface Login Banner

You can now replace or modify the login banner and prompt presented via a telnet 
connection or on the router console. The method uses the placement of an optional 
text file on the router flash, named “oem.txt.” If this file is present when a 
Technician Interface initializes for a potential login from console or via telnet, its 
contents govern the nature of the login banner. This file can be used for explicit 
identification purposes (positive indication that the desired system has been 
reached), security concerns (a nonspecific banner to avoid aiding unauthorized 
accesses), or cosmetic reasons. 

The rules are as follows:

• By default, in the absence of the file “oem.txt,” the login banner and prompt 
appear as follows:

Nortel Networks, Inc. and its Licensors. 
Copyright 1992,1993,1994,1995,1996,1997,1998,1999,2000,2001,2002.
All rights reserved.

Login:

• If the file “oem.txt” is present, its contents replace only the “Nortel Networks, 
Inc.” portion of the banner:

Chicken Delight - We Deliver!! and its Licensors.
Copyright 1992,1993,1994,1995,1996,1997,1998,1999,2000,2001,2002.
All rights reserved.

Login: 

• If the contents of “oem.txt” begin with the string "*NO BANNER*" 
(excluding quotes), the login banner is suppressed, but prompt is retained:

Login: 
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• If the "*NO BANNER*" string is followed by nonblank characters, they 
become the banner/prompt:

Enter user name:

Note: While changes to the “oem.txt” file will be reflected when the next 
telnet connection is established, the change to the console login banner/prompt 
will not take effect until the next system reset. 
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Chapter 13
Configuring Traffic Filters and Protocol

Prioritization

Version 15.4.0.0

The following section is new to Configuring Traffic Filters and Protocol 
Prioritization.

Configuring IP Outbound Traffic Filters Using the BCC

Outbound traffic filters act on packets that the router forwards to a local area 
network (LAN) or (WAN) through a particular interface. Protocol prioritization 
allows the router to sort traffic into prioritized delivery queues (high, normal, 
low). These queues affect the sequence in which data leaves an interface. You can 
create outbound traffic filters for the following interfaces: ATM, Ethernet 
(10Base-T or 100 Base-T), FDDI, token ring, HSSI, MCE1, MCT1, FT1/FE1, and 
synchronous. The BayRS version 15.4.0.0 implementation of this feature has the 
following limitations:

• Supports traffic with IP headers only

• Allows you to create traffic filters only; the ability to create templates is not 
available with BayRS 15.4.0.0

• Does not allow you to change the order of precedence for outbound filters

• Is not supported on X.25 interfaces

• Is not supported on Data Link Switching (DLSw) interfaces
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The following sections describe how to use the BCC to enable protocol 
prioritization and configure outbound traffic filters.

You implement protocol prioritization by applying an outbound traffic filter that 
includes a prioritizing (priority queue) action. This type of outbound traffic filter 
is called a priority filter. The next section describes how to edit protocol 
prioritization parameters that affect the way priority filters work.

Configuring Protocol Prioritization

To configure priority queues with default values, do the following:

1. Configure protocol priority on the circuit, as described in this section.

2. Apply outbound traffic filters with prioritizing action to the circuit, as 
described in “Creating Outbound Traffic Filters,” later in this chapter.

To configure protocol priority, navigate to the interface prompt (for example, box; 
ethernet/2/1) and enter: 

protocol-priority

For example, the following command configures protocol priority on connector 1 
of an ethernet module installed in slot 2:

ethernet/2/1# protocol-priority
protocol-priority/ethernet/2/1#

Displaying Protocol Priority Parameter Values

To view the current values of the protocol-priority parameters, navigate to the 
protocol priority prompt (for example, box; ethernet/2/1; protocol-priority) and 
enter:

info

Topic Page

Configuring Protocol Prioritization 13-2

Customizing Protocol Prioritization 13-3

Creating Outbound Traffic Filters 13-8
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For example, the following command shows the current parameter values for 
Protocol Priority:

protocol-priority/ethernet/2/1# info
dequeue-at-line-rate disabled
high-queue-percentage-bandwidth 70
high-queue-size 20
high-water-packets-clear 0
low-queue-percentage bandwidth 10
low-queue-size 20
max-high-queue-latency 250
normal-queue-percentage-bandwidth 20
normal-queue-size 20
prioritization-algorithm-type bandwidth-allocation
state enabled

protocol-priority/ethernet/2/1#

Customizing Protocol Prioritization

When you configure Protocol Priority on a circuit, the router uses default values 
that help determine how priority filters work. These defaults are designed to work 
well for most configurations. However, you can customize protocol prioritization 
to maximize its impact on your network.

For information about when you’d want to customize Protocol Prioritization, see 
Chapter 2 in Configuring Traffic Filters and Protocol Prioritization.

To customize Protocol Prioritization parameters, use the following procedures:.

Procedure Page

Displaying Protocol Priority Parameter Values 13-2

Enabling or Disabling Protocol Priority 13-4

Specifying the High Queue Size 13-4

Specifying the Normal Queue Size 13-5

Specifying the Low Queue Size 13-5

Specifying the Maximum High Queue Latency 13-5

Clearing the High Water Marks 13-6

Selecting the Prioritization Algorithm Type 13-6

Selecting the High Queue Percentage Bandwidth 13-7

Selecting the Normal Queue Percentage Bandwidth 13-7
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Enabling or Disabling Protocol Priority

When you configure Protocol Priority on a circuit, it is enabled by default. To 
disable Protocol Priority, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

state disabled

If you set this parameter to disabled, all outbound traffic filters will be disabled on 
this interface. Setting this parameter to disabled is useful if you want to 
temporarily disable all outbound traffic filters rather than delete them.

To re-enable Protocol Priority, navigate to the protocol priority prompt (for 
example, box; ethernet/2/1; protocol-priority) and enter:

state enabled

For example, the following command enables Protocol Priority on the selected 
circuit:

protocol-priority/ethernet/2/1# state enabled
protocol-priority/ethernet/2/1#

Specifying the High Queue Size

To specify the maximum number of packets in the High queue at any one time, 
regardless of packet size, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

high-queue-size <value>

value is any integer value; the default is 20.

For example, the following command changes the high queue size to 50:

protocol-priority/ethernet/2/1# high-queue-size 50
protocol-priority/ethernet/2/1#

Selecting the Low Queue Percentage Bandwidth 13-8

Controlling the Dequeuing of Packets 13-8

Procedure Page
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Specifying the Normal Queue Size

To specify the maximum number of packets in the Normal queue at any one time, 
regardless of packet size, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

normal-queue-size <value>

value is any integer value; the default is 20 (200 for Frame Relay).

For example, the following command changes the normal queue size to 50:

protocol-priority/ethernet/2/1# normal-queue-size 50
protocol-priority/ethernet/2/1#

Specifying the Low Queue Size

To specify the maximum number of packets in the Low queue at any one time, 
regardless of packet size, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

low-queue-size <value>

value is any integer value; the default is 20.

For example, the following command changes the low queue size to 50:

protocol-priority/ethernet/2/1# low-queue-size 50
protocol-priority/ethernet/2/1#

Specifying the Maximum High Queue Latency

To specify the greatest delay that a high-priority packet can experience and, 
consequently, how many normal-priority or low-priority bits can be in the transmit 
queue at any one time, navigate to the protocol priority prompt (for example, box; 
ethernet/2/1; protocol-priority) and enter:

max-high-queue-latency <value>

value is between 100 to 5000 ms, inclusive. The default is 250 ms. Nortel 
Networks recommends accepting the default value of 250 ms.

For example, the following command changes the maximum high queue latency 
to 500:

protocol-priority/ethernet/2/1# max-high-queue-latency 500
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protocol-priority/ethernet/2/1#

Clearing the High Water Marks

When you change the queue depth (by changing the value of the high queue, 
normal queue, or low queue size), you can also reset the high-water mark by 
changing the value of this parameter. When you change the value of this 
parameter, you reset the high-water mark for all three queues to zero.

To clear the existing high-water marks, navigate to the protocol priority prompt 
(for example, box; ethernet/2/1; protocol-priority) and enter:

high-water-packets-clear <value>

value is any integer value; the default is 0.

For example, the following command clears the existing high-water marks for the 
priority queues:

protocol-priority/ethernet/2/1# high-water-packets-clear 1
protocol-priority/ethernet/2/1#

Selecting the Prioritization Algorithm Type

To select the dequeuing algorithm that protocol prioritization uses to drain priority 
queues and transmit traffic, navigate to the protocol priority prompt (for example, 
box; ethernet/2/1; protocol-priority) and enter:

prioritization-algorithm-type {bandwidth-allocation | strict}

If you select strict queueing, the router always transmits traffic in the High queue 
before transmitting traffic in the other queues. If you accept the default, bandwidth 
allocation queueing, the router transmits traffic in a queue until the utilization 
percentage for that queue is reached; then, the router transmits traffic in the 
next-lower-priority queue. (You configure the percentages for bandwidth 
allocation by setting the high-queue, normal-queue, and low-queue percentage 
bandwidth parameters).

For example, the following command changes the dequeuing algorithm to strict:

protocol-priority/ethernet/2/1# prioritization-algorithm-type strict
protocol-priority/ethernet/2/1#
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Selecting the High Queue Percentage Bandwidth

If you selected the bandwidth allocation dequeuing algorithm, to specify the 
percentage of the synchronous line’s bandwidth allocated to traffic that has been 
sent to the High queue, navigate to the protocol priority prompt (for example, box; 
ethernet/2/1; protocol-priority) and enter:

high-queue-percentage-bandwidth <percent>

percent is a value between 0 to 100, inclusive. The default is 70 percent. When 
you set this parameter to a value less than 100, each time the percentage of 
bandwidth used by high-priority traffic reaches this limit, the router transmits 
traffic in the Normal and Low queues, up to the configured percentages for those 
priority queues. The high queue, normal queue, and low queue percentage 
bandwidth values must total 100.

For example, the following command changes the high queue percentage 
bandwidth to 50 percent:

protocol-priority/ethernet/2/1# high-queue-percentage-bandwidth 50
protocol-priority/ethernet/2/1#

Selecting the Normal Queue Percentage Bandwidth

If you selected the bandwidth allocation dequeuing algorithm, to specify the 
percentage of the synchronous line’s bandwidth allocated to normal-priority 
traffic, navigate to the protocol priority prompt (for example, box; ethernet/2/1; 
protocol-priority) and enter:

normal-queue-percentage-bandwidth <percent>

percent is a value between 0 to 100, inclusive. The default is 20 percent. The high 
queue, normal queue, and low queue percentage bandwidth values must total 100.

For example, the following command changes the normal queue percentage 
bandwidth to 30 percent:

protocol-priority/ethernet/2/1# normal-queue-percentage-bandwidth 
30
protocol-priority/ethernet/2/1#
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Selecting the Low Queue Percentage Bandwidth

If you selected the bandwidth allocation dequeuing algorithm, to specify the 
percentage of the synchronous line’s bandwidth allocated to low-priority traffic, 
navigate to the protocol priority prompt (for example, box; ethernet/2/1; 
protocol-priority) and enter:

low-queue-percentage-bandwidth <percent>

percent is a value between 0 to 100, inclusive. The default is 10 percent. The high 
queue, normal queue, and low queue percentage bandwidth values must total 100.

For example, the following command changes the low queue percentage 
bandwidth to 20 percent:

protocol-priority/ethernet/2/1# low-queue-percentage-bandwidth 20
protocol-priority/ethernet/2/1#

Controlling the Dequeuing of Packets

To control the dequeuing of packets from the queues to the driver, navigate to the 
protocol priority prompt (for example, box; ethernet/2/1; protocol-priority) and 
enter:

dequeue-at-line-rate {disabled | enabled}

When limited bandwidth is available, select enabled to reduce delay in queues that 
need a constant delay rate, such as Voice over IP. Accept the default, disabled, if 
you do not need constant bandwidth for traffic that requires a constant delay rate.

For example, the following command enabled the dequeue-at-line-rate feature:

protocol-priority/ethernet/2/1# dequeue-at-line-rate enabled
protocol-priority/ethernet/2/1#

Creating Outbound Traffic Filters

You can create outbound traffic filters for the following interfaces: Ethernet 
(10Base-T or 100BASE-T), FDDI, token ring, HSSI, MCE1, MCT1, and 
synchronous. The current implementation of this feature supports only traffic with 
IP headers. The following section describes how to create an IP-routed outbound 
traffic filter for an interface.
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To create outbound traffic filters, use the following procedures:

Creating a Filter for IP-Routed Packets

To create an outbound traffic filter for IP-routed packets, navigate to the protocol 
priority prompt (for example, box; serial/3/1; protocol-priority) and enter:

ip-outbound-filter <filter_name>

filter_name is a descriptive name for the filter. For example, use the name 
drop_telnet_s31 for a filter that drops outbound Telnet traffic on a serial module in 
slot 3, connector 1.

For example, the following command creates an outbound filter with the name 
drop_telnet_s31:

protocol-priority/serial/3/1# ip-outbound-filter drop_telnet_s31
ip-outbound-filter/drop_telnet_s31/S31#

Displaying Priority Outbound Filter Parameter Values

To view the current values of the outbound filter, navigate to the traffic filter 
prompt (for example, box; serial/3/1; protocol-priority; ip-outbound-filter 
<filter_name>) and enter:

info

For example, the following command shows the current parameter values for the 
priority outbound filter:
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ip-outbound-filter/drop_telnet_s31/S31# info
filter-name drop_telnet_s31
state enabled

ip-outbound-filter/drop_telnet_s31/S31#

Enabling or Disabling the Outbound Filter

When you create an outbound filter on a circuit, it is enabled by default. To disable 
the filter, navigate to the traffic filter prompt (for example, box; serial/3/1; 
protocol-priority; ip-outbound-filter <filter_name>) and enter:

state disabled

If you set this parameter to disabled, the specified outbound traffic filter will be 
disabled on this interface. Setting this parameter to disabled is useful if you want 
to temporarily disable the outbound traffic filter rather than delete it.

To re-enable the outbound filter, navigate to the traffic filter prompt (for example, 
box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>) and enter:

state enabled

For example, the following command enables the outbound filter on the selected 
circuit:

ip-outbound-filter/drop_telnet_s31/S31# state enabled
ip-outbound-filter/drop_telnet_s31/S31#

Specifying Match Criteria for IP-to-IP Outbound Traffic Filters

The match criteria in a filter specify which fields in the IP header of each packet 
must contain the values that you specify. You can also specify certain fields in the 
headers of TCP and UDP packets contained in the IP data field of IP packets. 

To prepare to specify the filtering criteria, navigate to the traffic filter prompt (for 
example, box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>) 
and enter:

match-ip-ip
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You can specify match criteria for filters as described in the following sections:

Specifying Source and Destination Networks As Match Criteria

To filter on source and destination networks, go to the match-ip-ip prompt (for 
example, (for example, box; serial/3/1; protocol-priority; ip-outbound-filter 
<filter_name>); match-ip-ip) and do the following for each source and destination 
network that you want to filter on:

1. Enter the following command:

{source | destination}-network <address_range>

<address_range> specifies a range of IP addresses for source and destination 
networks. 

The source network or destination network prompt appears.

2. Go back to the match-ip-ip prompt:

back

Example 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# source-network 
10.1.0.0-10.1.255.255 
source-network/ip-outbound-filter/drop_telnet_s31/S31/
10.1.0.0-10.1.255.255# back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
destination-network 10.2.0.0-10.2.255.255
destination-network/ip-outbound-filter/drop_telnet_s31/S31/
10.2.0.0-10.2.255.255# back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#
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Specifying Source and Destination TCP and UDP Ports As Match Criteria

To filter on TCP ports, UDP ports, or both, you can specify only one of the 
following criteria for each filter:

• Source TCP ports, destination TCP ports, or both

• Source UDP ports, destination UDP ports, or both

• Both destination TCP and UDP ports

• Both source TCP and UDP ports

After you specify one of these options, the BCC prevents you from specifying 
another in the same filter. For example, if you specify source TCP ports, you can 
also specify destination TCP ports, but you cannot specify source UDP ports.

When you specify one of these values, the BCC automatically assigns the 
associated protocol ID (6 for TCP or 17 for UDP) to the protocol parameter. 
Therefore, you cannot modify the protocol parameter of a filter that specifies a 
TCP or UDP port value.

To filter on TCP or UDP ports, navigate to the match-ip-ip prompt (for example, 
box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>); 
match-ip-ip) and enter the following command: 

<parameter> {<range_of_ports>}

parameter is one of the following (Table 13-1):

Table 13-1. TCP and UDP Match Criteria Parameters

Parameter Specifies

pri-ip-ip-src-tcp-ports Source TCP port through which traffic is exiting the 
network

pri-ip-ip-dest-tcp-ports Destination TCP port through which traffic is entering 
the network

pri-ip-ip-src-udp-ports Source UDP port through which traffic is exiting the 
network

pri-ip-ip-dest-udp-ports Destination UDP port through which traffic is entering 
the network
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range_of_ports is a space-delimited list.

Table 13-2 lists some common TCP port values. 

Table 13-3 lists some common UDP port values.

pri-ip-ip-dest-tcp-udp-ports Both destination TCP and UDP ports through which 
traffic is entering the network

pri-ip-ip-src-tcp-udp-ports Both source TCP and UDP ports through which traffic is 
exiting the network

Table 13-2. Common TCP Ports

Description TCP Port

FTP 20, 21

Telnet 23

SMTP 25

DNS 53

Gopher 70

World Wide Web http 80-84

DLSw read port 2065

DLSw write port 2067

Table 13-3. Common UDP Ports

Description UDP Port

DNS 53

TFTP 69

SNMP 161

SNMPTRAP 162

Table 13-1. TCP and UDP Match Criteria Parameters

Parameter Specifies
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Example - Source TCP Port

This example specifies source TCP ports 20, 80, and 53 through 56 as match 
criteria for the filter template telnet-in:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-src-tcp-ports {20 80 53-56}
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Example - Destination TCP Port

This example specifies destination TCP ports 30, 90, and 50 through 53 as match 
criteria: 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-dest-tcp-ports {30 90 50-53}
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Example - Source UDP Port

This example specifies source UDP port 162 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-src-udp-ports 162
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 

Example - Destination UDP Port

This example specifies destination UDP port 69 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-dest-udp-ports 69
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 

Example - Destination TCP and UDP Ports

This example specifies both destination TCP and UDP ports 53 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-dest-tcp-udp-ports 53
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Example - Source TCP and UDP Ports

This example specifies both source TCP and UDP ports 53 as match criteria:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-src-tcp-udp-ports 53
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
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Specifying Protocol Identifiers As Match Criteria

Internet Protocol Version 4 (IPv4) specifies an 8-bit protocol field to identify the 
next-level protocol. You can use the protocol field to identify traffic that you want 
to accept or drop.

If you specify a protocol other than TCP or UDP, the software prevents you from 
filtering on the TCP or UDP source or destination. Otherwise, the offset 
associated with one of the parameters in the non-UDP/TCP packet could 
coincidentally match the filter, and the software would perform the filter’s action.

To filter traffic using the protocol field, navigate to the match-ip-ip prompt (for 
example, box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>); 
match-ip-ip) and enter the following command:

pri-ip-ip-protocol {<list_of_protocols>}

list_of_protocols can include any number of protocol identifiers. It can also 
specify ranges of protocol identifiers.

Table 13-4 lists some common protocol ID codes for IP traffic.

Note: If you filter on a TCP or UDP source or destination, the software 
automatically changes the value to the protocol number associated with TCP 
or UDP.

Table 13-4. Common Protocol IDs for IP Traffic

Protocol  ID Code (Decimal)

ICMP (Internet Control Message Protocol) 1

IGMP (Internet Group Management Protocol) 2

TCP (Transmission Control Protocol) 6

EGP (Exterior Gateway Protocol) 8

IGP (Interior Gateway Protocol) 9

UDP (User Datagram Protocol) 17

RSVP (Resource Reservation Protocol) 46

GRE (Generic Routing Encapsulation) 47

NHRP (Next Hop Resolution Protocol) 54

OSPF (Open Shortest Path First) 89
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Example

To match IGP packets, enter the following command:

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-protocol 9
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying the Type of Service (ToS) As Match Criteria

You can discriminate higher priority traffic from lower priority traffic by 
specifying the type of service as the matching criteria for the traffic filter. 

To specify the type of service portion of the IP header, enter the following 
command at the match-ip-ip prompt (for example, box; serial/3/1; 
protocol-priority; ip-outbound-filter <filter_name>); match-ip-ip) and enter:

pri-ip-ip-tos {<list_of_values>}

list_of_values is a space-delimited list. It can be any number of values from 0 
through 65,535. It can also specify ranges of values. Use a dash instead of a space 
to indicate a range. 

Example

In this example, the router matches packets whose ToS bit is set to 1. 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# pri-ip-ip-tos 1
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying TCP-Established Match Criteria

By default, the router does not filter packets on the ACK and RESET bits in the 
TCP header. To allow the router to filter packets with the ACK and RESET bits, 
go to the match-ip-ip prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); match-ip-ip) and enter the following 
command:

pri-ip-ip-tcp-established {on | off}
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Example

In this example, the router filters packets with the ACK and RESET bits in the 
TCP header turned on.

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-ip-tcp-established on
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying Match Criteria for IP-to-Source Routing Outbound Traffic 
Filters

To prepare to specify the filtering criteria, navigate to the match-ip-ip prompt (for 
example, box; serial/3/1; protocol-priority; ip-outbound-filter <filter_name>; 
match-ip-ip) and enter:

match-ip-source-routing

Specifying SSAPs as Match Criteria

To filter on a range of session service access points (SSAPs), navigate to the 
match-ip-source-routing prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); match-ip-ip; match-ip-source-routing) and 
enter the following command: 

pri-ip-sr-ssap <range>

range specifies any number of session service access points (SSAPs). It can
also specify ranges of SSAPs.

Specifying Source and Destination Networks As Match Criteria

To filter on source and destination networks, go to the match-ip-source-routing 
prompt (for example, (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); match-ip-ip; match-ip-source-routing) and 
enter the following command for each source and destination network that you 
want to filter on:

{pri-ip-sr-src | pri-ip-sr-dest}-addr <address_range>

<address_range> specifies a range of addresses for source and destination 
networks. 
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Example 

match-ip-source-routing/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-sr-src-addr 10.1.0.0-10.1.255.255
pri-ip-sr-src-addr/ip-outbound-filter/drop_telnet_s31/S31/
10.1.0.0-10.1.255.255# back
match-ip-source-routing/ip-outbound-filter/drop_telnet_s31/S31# 
pri-ip-sr-dest-addr 10.2.0.0-10.2.255.255
pri-ip-sr-dest-addr/ip-outbound-filter/drop_telnet_s31/S31/
10.2.0.0-10.2.255.255# back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31#

Specifying Match Criteria for IP-to-PPP Outbound Traffic Filters

To prepare to specify the filtering criteria, navigate to the match-ip-ip prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip) and enter:

match-ip-ppp

Specifying Protocol IDs as Match Criteria

To filter on a range of protocol IDs, navigate to the match-ip-ppp prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip; match-ip-ppp) and enter the 
following command: 

pri-ip-ppp-protocol-id <list_of_protocols>

list_of_protocols can include any number of protocol identifiers. It can also 
specify ranges of protocol identifiers.

Specifying Match Criteria for IP-to-Frame Relay Outbound Traffic 
Filters

To prepare to specify the filtering criteria for IP-to-frame-relay outbound filters, 
navigate to the match-ip-ip prompt (for example, box; mct1 4/1; logical-line 
<MCT_line_no>; protocol-priority; ip-outbound-filter <filter_name>; 
match-ip-ip) and enter:

match-ip-frame-relay
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Specifying DLCIs as Match Criteria

To filter on a range of DLCIs, navigate to the match-ip-frame-relay prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip; match-ip-frame-relay) and enter 
the following command: 

pri-ip-fr-{dlci2byte | dlci3byte |dlci4byte} <byte_range>

byte_range specifies the PVC identification number (used by the frame relay
network to direct data) or ranges of numbers on which you want to filter outbound
traffic.

For the 2-byte DLCI address field, the valid values are 16 to 1007. Enter the
decimal number that the frame relay provider assigns.

For the 3-byte DLCI address field, the valid values are 1024 to 64511. Enter the 
decimal number that the frame relay provider assigns. 

For the 4-byte DLCI address field, the valid values are 131072 to 4194303. Enter 
the decimal number that the frame relay provider assigns. 

Specifying NLPIDs as Match Criteria

To filter on a range of NLPIDs, navigate to the match-ip-frame-relay prompt (for 
example, box; mct1 4/1; logical-line <MCT_line_no>; protocol-priority; 
ip-outbound-filter <filter_name>; match-ip-ip; match-ip-frame-relay) and enter 
the following command: 

pri-ip-fr-nlpid <nlpid_range>

nlpid_range specifies any number of network layer protocol identifiers 
(NLPIDs). It can also specify ranges of NLPIDs. 

Specifying the Action of Outbound Traffic Filters

For outbound traffic filters, you can specify different types of action:

• Filtering Actions

• Prioritizing Actions

• Dial Service Actions
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Filtering Actions

The filter action determines what happens to packets that match the filter criteria. 
You can configure IP outbound traffic filters to perform the following actions:

• Accept

The router processes any packet that matches the filter criteria and ranges.

• Drop

The router does not route any packet that matches the filter criteria and ranges.

• Log

For every packet that matches the filter criteria, the router sends an entry to 
the system event log. You can specify the log action in combination with other 
actions.

To specify an action, navigate to the actions prompt (for example, box; serial/3/1; 
protocol-priority; ip-outbound-filter <filter_name>); actions) and enter:

action {accept | drop}

For example, to change the action to drop, enter the following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# action drop
actions/ip-outbound-filter/drop_telnet_s31/S31#

To log an entry to the system Events log for every packet that matches the filter 
criteria and ranges, navigate to the ip-outbound-filter prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>) and enter:

action-log on

For example, to log entries to the Events log, enter the following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# action-log on
actions/ip-outbound-filter/drop_telnet_s31/S31#

The default value for this parameter is off.

Note: Specify the Log action to record abnormal events only; otherwise, the 
Events log will fill up with filtering messages, leaving no room for critical log 
messages.
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Prioritizing Actions

You can apply the following actions to outbound traffic filters for WAN protocols:

• High 

Directs packets that match the filter criteria and ranges to the High queue

• Low 

Directs packets that match the filter criteria and ranges to the Low queue

• Length 

Uses the length of packets to determine the priority queue

Outbound traffic filters with a prioritizing action are called priority filters. 

To direct packets that match the filter criteria and ranges to the High queue, 
navigate to the actions prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); actions) and enter:

action high-queue

To direct packets that match the filter criteria and ranges to the Low queue, 
navigate to the actions prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); actions) and enter:

action low-queue

To use the length of packets to determine the priority queue, navigate to the 
actions prompt (for example, box; serial/3/1; protocol-priority; 
ip-outbound-filter <filter_name>); actions), and use the following procedure:

1. Enter the following command:

action length

The actions prompt is re-displayed (e.g., actions/ip-outbound-filter/test/S31#)

Note: You can apply prioritizing actions only to MCE1, MCT1, and 
synchronous interfaces. The BCC does not support priority filters on the LAN 
interfaces.
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2. At the actions prompt, enter:

prioritization-length

The prioritization-length prompt is displayed (e.g., prioritization-length/
ip-outbound-filter/test/S31#)

3. Enter one of the following commands:

{greater-than-queue <greater_than_queue_value> | less-than-or 
equal-queue <less_than_or_equal_queue_value> | packet-length 
<packet_length_value>}

greater_than_queue_value specifies which queue a packet is placed in if its 
packet length is greater than the value of the packet-length parameter. Valid 
values are high, low, or normal.

less_than_or_equal_queue_value specifies which queue a packet is placed in 
if its packet length is less than or equal to the value of the packet-length 
parameter. Valid values are high, low, or normal.

packet_length_value defines a packet length measurement to which each 
packet is compared. An action is imposed on every packet, depending on 
whether it is less than, equal to, or greater than the value you set for this 
parameter. This action depends on the values of the less-than-or-equal-queue 
and the greater-than-queue parameters. Enter a packet length value in bytes (0 
to 4608). The default is 256. 

Example

This example specifies that packets with lengths greater than 156 bytes are placed 
in the normal queue and that packets with lengths less than or equal to 156 bytes 
are placed in the high queue.

actions/ip-outbound-filter/drop_telnet_s31/S31# action length
actions/ip-outbound-filter/drop_telnet_s31/S31# prioritization-length
prioritization-length/ip-outbound-filter/drop_telnet_s31/S31# 
greater-than-queue normal
prioritization-length/ip-outbound-filter/drop_telnet_s31/S31# 
less-than-or-equal-queue high
prioritization-length/ip-outbound-filter/drop_telnet_s31/S31# 
packet-length 156
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Dial Service Actions

You can apply the following actions to outbound traffic filters for interfaces 
configured as dial-up lines:

• No Call 

Packets that match the filter criteria and ranges are dropped and do not initiate 
a dial connection. (By default, packets transmitted on dial-on-demand lines 
always trigger the router to establish a connection.)

• No Reset 

Packets that match the filter criteria and ranges are processed but do not reset 
the inactivity timer.

To enable the no-call feature, navigate to the actions prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>; actions) and 
enter:

no-call on

For example, to drop packets that match the filter criteria and ranges, enter the 
following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# no-call on
actions/ip-outbound-filter/drop_telnet_s31/S31#

To enable the no-reset feature, navigate to the actions prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>; actions) and 
enter:

no-reset on

Note: If you attempt to delete an IP traffic filter for which the action parameter 
is set to “length,” the value for that parameter changes to “accept” and the IP 
traffic filter is not deleted.

Note: Although No Call and No Reset are available when creating any 
outbound traffic filter, these actions are useful only on dial-up interfaces such 
as synchronous modem lines or MCT1 interfaces configured with ISDN PRI.
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For example, to process packets that match the filter criteria and ranges but do not 
reset the inactivity timer, enter the following command:

actions/ip-outbound-filter/drop_telnet_s31/S31# no-reset on
actions/ip-outbound-filter/drop_telnet_s31/S31#

Specifying User-Defined Criteria

You can specify user-defined criteria in IP outbound traffic filters by specifying an 
offset and length based on the reference fields in the IP header.

To specify user-defined criteria, navigate to the match prompt (for example, box; 
serial/3/1; protocol-priority; ip-outbound-filter <filter_name>); match-ip-ip) 
and enter:

user-defined reference <value> offset <value> bitwidth <value> range <value>

reference is a known bit position in the packet header. Valid values are 
ip-wan-header-start, ip-wan-header-end, x25-mac-start, x25-snap-start, 
x25-nlpid-start, x25-nlpdu-start.

offset specifies the first position of the filtered bit pattern in relation to the 
reference point (measured in bits).

bitwidth specifies the total bit length that matches the packet criteria.

range specifies a minimum and maximum target value to apply to the match 
criterion. For a single value, you must specify the minimum value in hexadecimal 
format. You can precede the value with 0x.

Example

This example specifies user-defined criteria to create an IP traffic filter that drops 
every packet that has a value of 192 at offset 96 from the beginning of the IP 
header. 

match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# user-defined 
reference ip-wan-header-start offset 96 bitwidth 16 range 0192
user-defined/filter/drop_telnet_231/start-ip-header/96/16/0192# 
back
match-ip-ip/ip-outbound-filter/drop_telnet_s31/S31# back
ip-outbound-filter/drop_telnet_231/S31# actions
actions/ip-outbound-filter/drop_telnet_s31/S31# action drop
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Chapter 14
Configuring VRRP Services

Version 15.3.0.0

The following section is new to Chapter 3, “Customizing VRRP” in Configuring 
VRRP Services.

Enabling or Disabling VRRP Ping

When enabled, this feature allows you to ping a master virtual router that is not the 
owner of the virtual IP address. By default, VRRP ping is disabled.

Using the BCC

To enable VRRP ping, access the virtual router (for example, box; ip; vrrp 
192.41.31.21/2 vr-ip-address 192.41.31.22) and enter:

ping-enable enabled

To disable VRRP ping, access the virtual router and enter:

ping-enable disabled

For example, to enable VRRP ping, enter the following command:

vrrp/192.41.31.21/2# ping-enable enabled
vrrp/192.41.31.21/2#
314470-15.5 Rev 00 14-1



BayRS Version 15.5.0.0 Document Change Notice
Using Site Manager

To enable VRRP ping, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window,
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose VRRP. The IP VRRP Configuration Parameters
window opens.

4. Click on a virtual router instance ID to
highlight it in the list of virtual routers.

The configuration that pertains to the
highlighted router appears.

5. Set the VRRP Address Ping parameter.
Click on Help or see the parameter
description on page A-31.

6. Click on Apply.

7. Click on Done. You return to the Configuration Manager
window.
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Chapter 15
Configuring X.25 Services

Version 15.4.0.0

The following sections are new to Configuring X.25 Services:

The section “X.25 PAD” contains an amendment to Chapter 1 in Configuring X.25 
Services.

Enabling the QLLC XID Retry Feature

Some OS/2 PCs configured with QLLC service for X.25 may take 20 to 50 
seconds to become ready to respond to an XID3. Consequently, the PC ignores the 
first XID3 that it received and cannot establish a connection. QLLC can now 
retransmit the XID3 every 10 seconds to the QLLC endstation until it receives a 
response. You can enable or disable this feature using the XID Retry parameter on 
the QLLC Mapping Table Configuration window. For information about 
accessing the parameters on the QLLC Mapping Table Configuration window, see 
Configuring X.25 Services. For more information about the XID Retry parameter, 
see Appendix A.

Topic Page

Enabling the QLLC XID Retry Feature 15-1

Setting the LLC Connect Timer 15-2

Accepting Incoming X.25 Calls for QLLC Service 15-2
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Setting the LLC Connect Timer

Some IBM hosts may take several minutes to establish connections over QLLC 
service for X.25, thereby exceeding the hard-coded 25 second timeout interval for 
DLSw. You can now configure the DLSw timeout interval to values greater than 
25 seconds (up to 600 seconds), using the Technician Interface.

Accepting Incoming X.25 Calls for QLLC Service

BayRS now accepts incoming X.25 calls for QLLC service from devices that do 
not have an X.121 calling address. Only one X.25 connection can be supported at 
any given time. You can enable or disable this feature using the No Calling 
Address parameter on the X.25 Service Configuration window. For information 
about accessing the parameters on the X.25 Service Configuration window, see 
Configuring X.25 Services. For more information about the No Calling Address 
parameter, see Appendix A.

X.25 PAD

An X.25 packet assembler/disassembler (PAD) provides access to an X.25 
network for devices, often character terminals, that are not capable of sending and 
receiving traffic across the X.25 interface. The PAD establishes and maintains the 
link with the packet-switched network, assembles and disassembles packets, 
communicates with the character terminal, and handles special control processes 
for the character terminal. Bay Networks X.25 PAD services comply with the 
CCITT so-called Triple X Standards: Recommendations X.3, X.28, and X.29.

Nortel Networks X.25 PAD services work only with X.25 SVCs for the current 
software release, and only with the ARN* router. Only one ISDB per ARN is 
supported.

For instructions on installing an X.25 PAD, see Installing the X.25 PAD. For 
instructions on using Site Manager to configure X.25 PAD Services, see Chapter 7 
in Configuring X.25 Services.

Caution: The default value for wfDlsLLCConnectTime is 25 seconds. You 
should never change this value unless absolutely necessary. This value should 
not be changed unless there is a justifiable network requirement.
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Chapter 16
Quick-Starting Routers

Version 15.3.0.0

The following section contains an amendment to Chapter 10, “Installing Site 
Manager on a SPARCstation” in Quick-Starting Routers.

SPARCstation System Requirements

To run Site Manager, your SPARCstation must meet the following hardware and 
software requirements:

• Supported workstations:

-- SPARCstation 10, 20

-- UltraSPARC

• Supported operating systems: Solaris 2.7 and 2.8

• Window environment:

-- CDE 1.0.1

-- OpenWindows 3.5

• 32 MB of RAM (64 MB recommended) 

• 145 MB of disk space

• 32 MB of swap space

• Network adapter appropriate for your network

• CD-ROM drive
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The following section contains an amendment to Chapter 12, Installing Site 
Manager on an HP 9000 Workstation in Quick-Starting Routers.

HP 9000 Workstation System Requirements

To run Site Manager, your HP 9000 workstation must meet the following 
hardware and software requirements:

• Supported workstations: HP 9000 Series 700 and 800

• Supported operating systems: HP-UX 10.20 (BayRS Version 15.3.0.0 up to, 
but not including 15.5.0.0) and HP-UX 11.00, including the complete services 
(network services) directory

• Window environment: CDE 1.0.1

• 32 MB of RAM 

• 145 MB of free disk space 

• 32 MB of swap space (64 MB recommended)

• Network adapter appropriate for your network

• CD-ROM drive
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Chapter 17
Upgrading Routers to BayRS Version 15.x

Version 15.2.0.0

The following section describes changes to Upgrading Routers to BayRS Version 
15.x.

Why You Upgrade Boot and Diagnostic PROMs

Table A-1 in “Why You Upgrade Boot and Diagnostic PROMs” of Upgrading 
Routers to BayRS Version 15.x has been modified to include the latest boot and 
diagnostic PROM file names and associated revision numbers for router platforms 
running BayRS Version 15.x.

Router
Platform

Diagnostic 
PROM
File Name 

Diagnos-
tic PROM
Revision
Number

Reason for 
Upgrading 
PROM

Boot PROM
File Name

Boot PROM 
Revision
Number

AN/ANH* andiag.exe 7.36 Strata flash fea-
ture support

anboot.exe 9.00d

ARN arndiag.exe 2.24 Strata flash fea-
ture support

arnboot.exe 1.27

arndiag.rom 2.24 Not applicable arnboot.rom 1.27

e7srom.rom 2.16 E7S feature sup-
port

isdb.rom 1.06

arn_pdbrom.rom 1.22 Not applicable
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ASN* asndiag.exe 2.36 Strata flash fea-
ture support

asnboot.exe 13.00 

asndiag.rom 2.36 Not applicable

BN* frediag.exe 5.16 Strata flash fea-
ture support

freboot.exe 13.00

fre4diag.ppc 1.14 FRE-4 board 
support

fre4boot.ppc 13.20

ARE (BN, 5782 MPE) arediag.ppc 1.22 Strata flash fea-
ture support

areboot.ppc 14.0.1.0

Passport 2430 pp2430diag.exe 2.06 Not applicable pp2430boot.ppc 15.4.0.0

pp2430ram.exe 2.06 Not applicable

pp2430diag.a 2.06 Not applicable

Passport 5430 pp5430diag.exe 1.16 Not applicable pp5430boot.ppc 15.4.2.0

pp5430ram.exe 1.16 Not applicable

pp5430diag.a 1.16 DS3/E3 feature 
support and 
quad serial 
feature support

System 5000* 
net modules

s5000diag.exe 0.04 Strata flash fea-
ture support

s5000boot.exe 13.00

Router
Platform

Diagnostic 
PROM
File Name 

Diagnos-
tic PROM
Revision
Number

Reason for 
Upgrading 
PROM

Boot PROM
File Name

Boot PROM 
Revision
Number
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Version 15.3.0.0

The following section describes changes to Upgrading Routers to BayRS Version 
15.x.

Site Manager Upgrade Prerequisites

Before you upgrade to Site Manager Version 15.x, review Site Manager system 
requirements.

Reviewing Site Manager System Requirements

Site Manager is a graphical user interface (GUI) for router configuration and 
management over an IP network. To run Site Manager Version 15.x, your PC, 
IBM* workstation, SPARCstation*, or HP* 9000 must meet the hardware and 
software requirements listed in Table 17-1.

Table 17-1. Site Manager System Requirements

Platform Hardware and Software Requirements

PC • 486 PC (Pentium recommended)
• Microsoft* Windows* 98 or 2000 (32-bit) or Windows NT*

Version 4.0 (32-bit)
• 16 MB of RAM (minimum)
• 90 MB of free disk space 
• Microsoft TCP/IP for Windows 98 or 2000 and compatible network 

adapter and driver
• CD-ROM drive 
• VGA monitor (SuperVGA monitor recommended)

SPARCstation • Supported workstations: SPARCstation 10, 20, and UltraSPARC
• Supported operating system: Solaris 2.7 and 2.8
• Window environments: CDE 1.0.1 and OpenWindows 3.5
• 32 MB of RAM (64 MB recommended) 
• 145 MB of disk space
• 32 MB of swap space
• Network adapter appropriate for your network
• CD-ROM drive
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Version 15.4.0.0

The following sections replace the existing sections in Chapter 4 and Chapter 5, 
respectively.

Upgrading and Verifying PROMs

When you upgrade PROMs, the system erases the existing PROM image and 
copies the contents of the newer PROM image file to the PROM. To verify the 
PROM, the system compares the contents of the new image file to the actual 
contents of the PROM. See Table A-1 on page A-2 of Upgrading Routers to 
BayRS Version 15.x. for Version 15.0 boot and diagnostic PROM file names and 
associated revision numbers for all router platforms.

IBM workstation • Supported workstations: RS/6000 340, 370, and PowerPC
• Supported operating system: IBM AIX* Version 4.3
• Window environments: CDE 1.0.1 and AIX Motif 1.2
• 32 MB of RAM (64 MB recommended)
• 140 MB of disk space
• 32 MB of swap space (64 MB recommended; use 96 MB of swap 

space with the NetView for AIX application)
• Network adapter appropriate for your network
• CD-ROM drive

HP 9000 • Supported workstations: HP 9000 Series 700 and 800
• Supported operating system: HP-UX 10.20 (BayRS Version 

15.3.0.0 up to, but not including, 15.5.0.0) and HP-UX 11.00, 
including the complete network services directory

• Window environment: CDE 1.0.1
• 32 MB of RAM 
• 145 MB of free disk space 
• 32 MB of swap space (64 MB recommended)
• Network adapter appropriate for your network
• CD-ROM drive

Note: Before you upgrade any router software, make sure that you save a copy 
of the original configuration file and boot image as a safeguard in case you 
encounter problems after upgrading.

Table 17-1. Site Manager System Requirements (continued)

Platform Hardware and Software Requirements
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You use the prom command from the Technician Interface to upgrade and verify 
the software on the diagnostic or boot PROM. This command is restricted to the 
Manager access level.

To upgrade and verify PROMs on a router, begin at the Technician Interface 
prompt and complete the following steps:

1. Establish a Technician Interface session with the router.

Enter the following command at the Technician Interface prompt: 

Manager

For more information about how to open a Technician Interface session with 
the router, see Using Technician Interface Software.

2. Insert a flash card with contiguous free space sufficient to accommodate 
the PROM images that you want to transfer to the router. 

To determine the amount of contiguous free space, display the directory of the 
flash volume by entering the following command at the Technician Interface 
prompt:

dir <volume_no.>:

volume_no. is the slot in which the flash card resides.

If you need more contiguous free space for the PROM image:

a. Delete unnecessary or obsolete files.

b. Compact the contents of the flash card by entering:

compact <volume_no.>:

The following message appears:

Compacting file system on volume <vol>:... 
This may take several minutes...Please wait...
100% Complete
Compaction completed

The space is compacted when the Technician Interface prompt reappears.

c. Verify that the amount of contiguous free space and available free 
space on the volume are the same by entering:

dir <volume_no.>:
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3. Transfer the PROM image files (for example, freboot.exe and frediag.exe) 
from the Site Manager PC or workstation to the router’s flash card by 
using the tftp command.

For more information about the tftp command, see Using Technician Interface 
Software.

4. Update the boot PROM by entering:

prom -w <volume_no.>:<Boot_PROM_source_file> <slot_ID>

volume_no. is the slot number of the boot PROM source file.

Boot_PROM_source_file is the name of the boot PROM source file (for 
example, freboot.exe).

slot_ID is the slot location of the boot PROM that you want to update. 

For AN, ANH, or ARN routers, the slot_ID is always 1.

For example, enter the following command:

prom -w 2:freboot.exe 3

This command erases the boot PROM image on slot 3 and copies the contents 
of the freboot.exe file on volume 2 to the PROM on slot 3.

5. Update the diagnostic PROM by entering:

prom -w <volume_no.>:<Diag_PROM_source_file> <slot_ID>

volume_no. is the slot number of the diagnostic PROM source file.

Diag_PROM_source_file is the name of the diagnostic PROM source file (for 
example, frediag.exe).

Note: To update the boot PROM on the Passport 2430 router, copy the latest 
pp2430boot.ppc file to the PCMCIA card along with the image. This router 
does not require that the boot code be burned in to the PROM.

Note: After you enter the prom command, it must run to completion. The 
[Control]-c (abort) command is disabled for the duration of the prom 
command execution. Updating takes from 2 through 10 minutes per PROM. 
Verifying takes up to 2 minutes per PROM. 
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slot_ID is the slot location of the diagnostic PROM that you want to update.

For AN, ANH, ARN, and Passport 2430 routers, the slot_ID is always 1.

For example, enter the following command:

prom -w 2:frediag.exe 3

This command erases the diagnostic PROM image on slot 3 and copies the 
contents of the frediag.exe file on volume 2 to the PROM on slot 3.

6. Upgrade PROMs on multiple slots on your router.

If you need to update PROM images on multiple slots, use a dash to indicate a 
range of slots (2-5), or use commas or spaces to separate multiple slot 
locations (2, 3, 5 or 2 3 5).

For example, enter the following command:

prom -w 2:frediag.exe 2, 3, 5

This command erases the diagnostic PROM images on slots 2, 3, and 5 and 
copies the contents of the frediag.exe file on volume 2 to the PROMs on slots 
2, 3, and 5.

7. Verify the PROM upgrade by entering the following command:

prom -v <volume_no.>:<PROM_source_file> <slot_ID>

For example, for a boot PROM, enter:

prom -v 1:arnboot.exe 1

For a diagnostic PROM, enter:

prom -v 1:arndiag.exe 1

The system verifies that the PROM image on a designated flash volume (that 
is, the image file used as a source for upgrading the PROM) matches the 
image actually stored in the boot or diagnostic PROM on the designated slot.

The console displays one of the following messages after the verification 
terminates:

prom: slot <slot ID> completed successfully
prom: PROM data does not match file data on slot <slot ID>

If the operation succeeds, the new images stored in the boot and diagnostic 
PROMs run when you reboot the router.

If the operation fails, the console displays a message describing the cause of 
the failure.
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Task 2: Updating the Existing Configuration File

This section describes how to upgrade your existing configuration files to support 
the new Version 15.x features. Optionally, you can create a new Version 15.x 
configuration file to replace your existing configuration file for the router.

Booting the Existing Configuration File

To upgrade an existing configuration file to Version 15.x, boot it on a router 
running a Version 15.x router software image. The router software loads the 
existing configuration file into router memory and updates the configuration file’s 
version stamp to match the Version 15.x router software. It does not, however, 
automatically save that version to the file on the flash card until you save the 
configuration file in dynamic mode. After you save the file in dynamic mode, 
reboot the router, using the updated configuration file.

Saving the Configuration File in Dynamic Mode

After you boot the router with a Version 15.x image and the existing configuration 
file, save the configuration file in dynamic mode to save it directly to the router. 

To save the existing configuration file in dynamic mode:

1. In the Site Manager window, choose Tools > Configuration Manager > 
Dynamic.

The Configuration Manager window opens (Figure 17-1), displaying the
real-time router hardware and software configuration.
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Figure 17-1. Configuration Manager Window

2. Choose File > Save As.

The Save Configuration File window opens (Figure 17-2).

Figure 17-2. Save Configuration File Window

3. Enter the configuration file name config.

4. Choose the correct volume by clicking in the Volume field.
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If the volume (slot location of the memory card on the router) is not the 
volume to which you want to save this file, choose another volume. 

5. Click on Save.

The File Saved window opens (Figure 17-3), asking you to confirm your 
decision to save the file.

Figure 17-3. File Saved Window

6. Click on OK.

This action saves the configuration file (config) to the router’s flash card with 
the Version 15.x version stamp.

7. Reboot the router with the updated configuration file.
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Chapter 18
Configuring PPP Services

Version 15.5.0.0

The following section is new to Chapter 3, “Customizing PPP Services” in 
Configuring PPP Services.

Multi-Class Extension to Multi-Link PPP

Beginning with version 15.5.0.0, BayRS supports RFC 2686, “Multi-Class 
Extension to Multi-Link PPP.” This feature provides a Layer 2 fragmentation and 
interleaving solution for Point-to-Point Protocol (PPP) wide area networks 
(WANs) that ensures high voice quality for voice over IP (VoIP) packets 
transmitted with data packets over a WAN. When this feature is enabled, large 
data packets are fragmented into smaller packets and higher-priority voice packets 
are sent between (interleaved with) the data packet fragments. 

Multiclass extension (MCE) to multilink PPP (MLPPP) is a QoS enhancement for 
bandwidth limited PPP connections (link speeds less than T1 speeds). Utilization 
of this feature minimizes the serialization delay and delay variance (jitter) of VoIP 
packets over low speed links by fragmenting large data packets and interleaving 
higher-priority voice packets with the data packet fragments. 

Packets are prioritized based on PPP service classes that are defined in the MLPPP 
header. A mapping has been defined between the PPP service classes and DiffServ 
Code Points (DSCPs) in IP headers based on Nortel Networks Service Class 
(NNSC) definitions. The mapping of PPP Classes to DSCP is shown in 
Table 18-1.
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The implementation of this feature supports six service classes using round robin 
weighted queues with integrated queuing and scheduling. Only long sequence 
number format is supported. If compression is enabled on the link, fragmentation 
and interleaving happens after compression is complete. 

For multiclass circuits, this feature can be configured to operate over a single line. 
However, if multiple lines are configured in the bundle, they all must have the 
same line speed. 

This feature can fully interoperate with the DiffServ marking of internally 
generated router packets feature discussed earlier in Chapter 5. 

Although RFC 2686 provides the option of prefix elision, Nortel Network’s 
implementation on BayRS Routers does not support it. This implementation also 
does not support DSQMS (Differentiated Services Queue Management System) 
on any interface on which this feature is enabled.

When utilizing this feature, it is recommended that you make sure that VoIP 
packets are marked with the EF DiffServ code point (for Premium service class). 
Voice packets that are marked with the EF DiffServ code point will never be 
fragmented.

Table 18-1. Mapping of PPP Classes to DiffServ Code Points (DSCP)

PPP Class Number Nortel Networks Service Class DiffServ Code Point

5 Premium EF, CS5

4 Critical, Network CS7, CS6

3 Platinum AF4x, CS4

2 Gold AF3x, CS3

1 Silver, Bronze AF2x, CS2, AF1x, CS1

0 Standard DF, CS0

Note: You must use Site Manager to configure the multilink multiclass PPP 
feature. There is no BCC support for this feature.
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Enabling and Disabling Multilink Multiclass on Interfaces

You enable and disable multilink multiclass on interfaces by setting the MultiLink 
MultiClass Enable parameter on the PPP Interface Lists window shown in 
Figure 18-1.

Figure 18-1. Site Manager PPP Interface List Window
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To enable or disable multilink multiclass on interfaces using Site Manager, 
perform the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose PPP.

3. Choose Interfaces. The PPP Interface List window opens.

4. Click on the interface for which you want 
to enable/disable multilink multiclass.

5. Set the Multilink MultiClass Enable 
parameter. Click on Help or see the 
parameter descriptions beginning on A-25.

6. Click on Apply.

7. Click on Done. You return to the Configuration Manager 
window.
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Specifying the Fragment Size for PPP Multilink Classes

You specify the minimum size of a packet that Multilink will fragment for each 
class of the interface by setting the Fragment Size parameter on the PPP 
Multiclass Classes window shown in Figure 18-2. 

You can set the fragment size for each of the 6 classes (x.0 through x.5) for the 
selected interface or use the default value (80). The six classes for the selected 
interface shown in Figure 18-2 are numbered 5.0 through 5.5. The fragment size is 
the minimum size of a packet to be fragmented for the selected class.

Figure 18-2. Site Manager PPP Multiclass Classes Window
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To specify the fragment size for PPP multilink multiclass using Site Manager, 
perform the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose PPP.

3. Choose Interfaces. The PPP Interface List window opens.

4. Click on the interface for which you want 
to set the fragment size.

5. Click on Classes. The PPP Multiclass Classes window 
opens for the selected interface. (only if 
Multilink MultiClass is enabled for the 
selected interface)

6. Click on the class for which you want to 
set the fragment size.

7. Set the Fragment Size parameter. Click 
on Help or see the parameter descriptions 
beginning on A-26.

8. Click on Apply.

9. Repeat steps 6 through 8 for each class 
for which you want to set the fragment 
size.

10. Click on Done. You return to the PPP Interface List 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Enabling and Disabling Multilink Multiclass on Dial-up Lines

For dial-in connections, in addition to enabling the Multilink MultiClass Enable 
parameter on the PPP Interface List window (Figure 18-1), you also must enable 
multilink multiclass on the dial-up line. 

You enable and disable multilink multiclass on dial-up lines by setting the 
Multilink Multiclass for Dialup parameter on the PPP Line Lists window shown 
in Figure 18-3.

Figure 18-3. Site Manager PPP Line Lists Window

Note: Multilink multiclass for dial-up lines applies only to incoming calls.
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To enable or disable multilink multiclass on dial-up lines using Site Manager, 
perform the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose PPP.

3. Choose Interfaces. The PPP Interface List window opens.

4. Click on the interface on which you want to 
enable/disable multilink Multiclass.

5. Click on Lines. The PPP Line Lists window opens for the 
selected interface.

6. Click on the line on which you want to 
enable/disable multilink multiclass.

7. Set the Multilink MultiClass Enable 
parameter. Click on Help or see the 
parameter descriptions beginning on A-26.

8. Click on Apply.

9. Repeat steps 6 through 8 for each line on 
which you want to enable/disable multilink 
multiclass.

10. Click on Done. You return to the PPP Interface List 
window.

11. Click on Done again. You return to the Configuration Manager 
window.
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Chapter 19
Configuring DLSw Services

Version 15.5.0.0

The following section supplements Chapter 4, “Customizing DLSw Services,” in 
Configuring DLSw Services.

DLSw Protocol Prioritization

DLSw protocol prioritization is an outbound filtering mechanism that enables you 
to assign preference to specific types of traffic supported by DLSw. DLSw 
protocol prioritization does not affect traffic as it enters the router, but affects the 
sequence in which traffic exits the router. 

Prior to version 15.5.0.0, only Site Manager could be used to configure DLSw 
protocol prioritization. The following sections explain how to use the BCC to 
configure this feature. For general information on DLSw protocol prioritization 
and for information on using Site Manager to configure it, see Configuring DLSw 
Services.
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Configuring DLSw Protocol Prioritization using the BCC

There are three parts to configuring DLSw protocol prioritization using the BCC:

• Configuring and enabling global parameters for DLSw protocol prioritization

• Customizing and enabling DLSw priority queues for specific DLSw peers

• Creating and enabling priority outbound filters for DLSw traffic

Configuring and Enabling Global Parameters for DLSw Protocol 
Prioritization

DLSw protocol prioritization is disabled by default. When you enable it, it takes 
effect using the currently configured values (default or customized) for all global 
DLSw protocol prioritization parameters. You can customize the DLSw protocol 
prioritization configuration to meet the specific needs of your site by changing the 
default settings of the global DLSw protocol prioritization parameters.

Customizing Global Parameters for DLSw Protocol Prioritization

To meet the specific needs of your site, you can modify the default settings of one 
or more of the following DLSw protocol prioritization global parameters:

• max-queue-buffers-unconfig-peers—specifies the maximum number of 
packets in each queue

• max-queue-size-unconfig-peers—specifies the maximum size (in bytes) of 
each queue

• default-bandwidth—specifies the number of queues to be used and allocates 
the bandwidth for each

max-queue-buffers-unconfig-peers

To specify the maximum number of packets in each queue, navigate to the 
dlsw-protocol-prioritization prompt (for example, box; dlsw; 
dlsw-protocol-prioritization) and enter:

Note: This section assumes that DLSw is already configured on an interface 
and that the peer table is complete. For information about configuring a circuit 
with DLSw and setting the slot, peer, and SAP parameters, refer to 
Configuring DLSw Services.
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max-queue-buffers-unconfig-peers <value>

value is an integer between 10 and 2147483647, inclusive. The default value is 50.

For example, to specify 100 as the maximum number of packets in each default 
queue, enter:

dlsw-protocol-prioritization# max-queue-buffers-unconfig-peers 100
dlsw-protocol-prioritization#

max-queue-size-unconfig-peers

To specify the maximum size (in bytes) of each default queue, navigate to the 
dlsw-protocol-prioritization prompt (for example, box; dlsw; 
dlsw-protocol-prioritization) and enter:

max-queue-size-unconfig-peers <value>

value is an integer between 5,000 and 2,147,483,647, inclusive. The default value 
is 16000.

For example, to specify 18000 as the maximum number of packets in each default 
queue, enter:

dlsw-protocol-prioritization# max-queue-size-unconfig-peers 18000
dlsw-protocol-prioritization#

default-bandwidth

To specify the number of default queues to be used and allocate the bandwidth for 
each, navigate to the dlsw-protocol-prioritization prompt (for example, box; 
dlsw; dlsw-protocol-prioritization) and enter:

default-bandwidth <value>

value is the allocated bandwidth for each of the 10 default priority queues (0-9). 
The default value is {60, 40, 0, 0, 0, 0, 0, 0, 0, 0}. Thus, the default setting utilizes 
only two priority queues by allocating 60% for queue 0, 40% for queue 1, and 0% 
for each of the remaining 8 queues. A valid value is any combination of 10 entries 
that add up to 100. Each entry represents the allocated bandwidth percentage for 
one of the 10 queues (0 through 9). You must enter a value for each of the 10 
queues. The sum of the specified bandwidth percentages must equal 100.
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For example, to allocate 10 percent of the bandwidth to each of the 10 queues, 
navigate to the dlsw-protocol-prioritization prompt (for example, box; dlsw; 
dlsw-protocol-prioritization) and enter:

dlsw-protocol-prioritization# default-bandwidth {10 10 10 10 10 10 10 10 
10 10} 
dlsw-protocol-prioritization# 

For example, to allocate 40 percent of the bandwidth to queue 0, 30 percent of the 
bandwidth to queue 1, and 30% of the bandwidth to queue 3, navigate to the 
dlsw-protocol-prioritization prompt (for example, box; dlsw; 
dlsw-protocol-prioritization) and enter:

dlsw-protocol-prioritization# default-bandwidth {40 30 30 0 0 0 0 0 0 0}
dlsw-protocol-prioritization# 

Enabling and Disabling DLSw Protocol Prioritization for Configured 
and Unconfigured Peers

When you enable DLSw protocol prioritization, it takes effect using the currently 
configured values (default or customized) for the global parameters.

Enabling DLSw protocol prioritization for configured peers

To enable DLSw protocol prioritization for configured peers, navigate to the 
global dlsw prompt (for example, box; dlsw) and enter:

dlsw-protocol-prioritization protocol-priority enabled

For example, to enable DLSw protocol prioritization for configured peers using 
the currently configured values for the global DLSw protocol prioritization 
parameters, navigate to the global dlsw prompt and enter:

dlsw# dlsw-protocol-prioritization protocol-priority enabled
dlsw-protocol-prioritization#

The default setting for protocol-priority is disabled. To disable DLSw protocol 
prioritization for configured peers after enabling it, navigate to the global dlsw 
prompt and enter:

dlsw-protocol-prioritization protocol-priority disabled
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Enabling DLSw protocol prioritization for unconfigured peers

To enable DLSw protocol prioritization for unconfigured peers using the currently 
configured values (default or customized) for the global DLSw protocol 
prioritization parameters, navigate to the global dlsw prompt (for example, box; 
dlsw) and enter:

dlsw-protocol-prioritization pp-unconfigured-peers enabled

For example, to enable DLSw protocol prioritization for unconfigured peers using 
the currently configured values for the global DLSw protocol prioritization 
parameters, navigate to the global dlsw prompt and enter:

dlsw# dlsw-protocol-prioritization pp-unconfigured-peers enabled
dlsw-protocol-prioritization#

The default setting for pp-unconfigured-peers is disabled. To disable DLSw 
protocol prioritization for unconfigured peers after enabling it, navigate to the 
global dlsw prompt and enter:

dlsw-protocol-prioritization pp-unconfigured-peers disabled

Customizing and Enabling DLSw Priority Queues for Specific Peers

You can fine tune DLSw priority queues for a specific peer by performing the 
following tasks:

• Specify a peer for custom DLSw priority queue configuration.

• Customize the DLSw priority queue parameters for the specified peer.

• Enable the specified peer’s custom DLSw priority queue configuration. 

Specifying a Peer for Custom DLSw Priority Queue Configuration

To specify a peer for custom DLSw priority queue configuration, navigate to the 
global dlsw prompt (for example, box; dlsw) and enter:

peer-queue-configuration peer-ip-addr <value>

Note: Peer-specific priority queue configurations take precedence over any 
currently enabled global DLSw protocol prioritization queue configuration.
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value is the IP address of the peer for which you want to configure custom DLSw 
priority queues.

For example, to specify custom DLSw priority queue configuration for a peer with 
an IP address of 192.168.1.1, enter:

dlsw# peer-queue-configuration peer-ip-addr 192.168.1.1
dlsw-peer-queue-configuration/192.168.1.1#

Customizing the DLSw Priority Queues for a Specific Peer

For a specified peer, you can override the currently configured global DLSw 
protocol prioritization parameters for the following elements:

• maximum buffer size for each queue

• maximum number of packets per queue

• allocated bandwidth for each of the 10 DLSw priority queues (0-9)

max-queue-buffers

To specify the maximum number of packets for each of a peer’s DLSw priority 
queues, navigate to the peer’s dlsw-peer-queue-configuration prompt (for 
example, box; dlsw; dlsw-peer-queue-configuration/<peer-IP-address>) and 
enter:

max-queue-buffers <value>

value is the maximum number of packets allowed in each of this peer’s priority 
queues. The range of valid values is from 10 to 2147483647, inclusive. The 
default is 50.

For example, to specify 200 as the maximum number of packets in each of the 
DLSw priority queues for a peer with an IP address of 192.168.1.1, navigate to the 
peer’s dlsw-peer-queue-configuration prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# max-queue-buffers 200
dlsw-peer-queue-configuration/192.168.1.1#

bandwidth-allocation

To allocate the bandwidth for each of the peer’s 10 DLSw priority queues, first 
navigate to the peer’s dlsw-peer-queue-configuration prompt (for example, box; 
dlsw; dlsw-peer-queue-configuration/<peer-IP-address>) and enter:
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bandwidth-allocation

This action displays the bandwidth-allocation/<peer-IP-address> prompt for the 
peer.

At the bandwidth-allocation/<peer-IP-address> prompt for the peer, enter:

dlsw-queue <value>

value is the allocated bandwidth for each of the 10 DLSw priority queues (0-9). 
The default value is {60, 40, 0, 0, 0, 0, 0, 0, 0, 0}. A valid value is any 
combination of 10 entries that add up to 100. Each entry represents the allocated 
bandwidth percentage for one of the 10 queues (0 through 9). You must enter a 
value for each of the 10 queues. The sum of the specified bandwidth percentages 
must equal 100.

For example, to allocate 10 percent of the bandwidth to each of the 10 queues, 
navigate to the peer’s bandwidth-allocation prompt and enter:

bandwidth-allocation/192.168.1.1# dlsw-queue {10 10 10 10 10 10 10 10 
10 10}
bandwidth-allocation/192.168.1.1#

max-queue-size

To specify the maximum size (in bytes) of each queue for a peer, navigate to the 
peer’s dlsw-peer-queue-configuration prompt (for example, box; dlsw; 
dlsw-peer-queue-configuration/<peer-IP-address>) and enter:

max-queue-size <value>

value is the maximum size (in bytes) for each of this peer’s priority queues. The 
range of valid values is from 5000 to 2147483647, inclusive. The default is 16000.

For example, to specify 20000 as the maximum number of packets allowed in 
each DLSw priority queue for a peer with an IP address of 192.168.1.1, navigate 
to the peer’s dlsw-peer-queue-configuration prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# max-queue-size 20000
dlsw-peer-queue-configuration/192.168.1.1#
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Enabling and Disabling a Peer’s DLSw Priority Queues

Peer-specific DLSw priority queues are disabled by default. To enable the 
customized DLSw priority queues that you have configured for a specific peer, 
navigate to the peer’s dlsw-peer-queue-configuration prompt (for example, box; 
dlsw; dlsw-peer-queue-configuration/<peer-IP-address>) and enter:

protocol-priority enabled

For example, to enable the customized DLSw priority queues that you configured 
for a peer with an IP address of 192.168.1.1, navigate to the peer’s 
dlsw-peer-queue-configuration prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# protocol-priority enabled
dlsw-peer-queue-configuration/192.168.1.1#

To disable the customized DLSw priority queues for a specific peer again, 
navigate to the peer’s dlsw-peer-queue-configuration prompt (for example, box; 
dlsw; dlsw-peer-queue-configuration/<peer-IP-address>) and enter:

protocol-priority disabled

For example, to disable the customized DLSw priority queues for a peer with an 
IP address of 192.168.1.1, navigate to the peer’s dlsw-peer-queue-configuration 
prompt and enter:

dlsw-peer-queue-configuration/192.168.1.1# protocol-priority disabled
dlsw-peer-queue-configuration/192.168.1.1#

Creating and Enabling Priority Outbound Filters for DLSw traffic

You can create priority filters for outbound DLSw traffic for specific peers that 
determine which traffic is sent to which DLSw priority queue (0 through 9).

To create a DLSw priority filter for outbound traffic, navigate to the global dlsw 
prompt (for example, box; dlsw) and enter:

dlsw-priority-outbound-filter-name <filter_name> peer-ip-addr <value>

filter_name is a descriptive name of the outbound traffic filter you are creating. 
For example, use the name dsap_01and02_q3 for a filter that sends traffic with a 
destination SAP address of 01 or 02 to queue 3. The filter name can be up to 30 
alphanumeric characters in length.
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value is the IP address of the peer for which you are creating the filter.

For example, to create a DLSw outbound filter named dsap_01and02_q3 for a 
DLSw peer with an IP address of 192.168.1.1, navigate to the global dlsw prompt 
(for example, box; dlsw) and enter:

dlsw-priority-outbound-filter-name dsap_01to02_q3 peer-ip-addr 192.168.1.1

Enabling and Disabling DLSw Outbound Filters

By default, an outbound filter is enabled when you create it. 

Disabling an Outbound Filter

To disable a DLSw priority filter, navigate to the peer’s filter prompt (for example, 
box; dlsw; dlsw-priority-outbound-filter/<filter_name>/<peer_address>) and 
enter:

state disabled

For example, to disable a DLSw outbound filter named dsap_01and02_q3 for a 
peer with an IP address of 192.168.1.1, navigate to the peer’s filter prompt (box; 
dlsw; dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1# state 
disabled

dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1#

Enabling an Outbound Filter

To enable a DLSw priority filter again, navigate to the peer’s filter prompt (for 
example, box; dlsw; dlsw-priority-outbound-filter/<filter_name>/
<peer_address>) and enter:

state enabled

For example, to enable a DLSw outbound filter named dsap_01and02_q3 for a 
peer with an IP address of 192.168.1.1, navigate to the peer’s filter prompt (box; 
dlsw; dlsw-priority-outbound-filter/dsap_01and02_q/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_01and02_q/192.168.1.1# state 
enabled
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dlsw-priority-outbound-filter/dsap_01and02_q/192.168.1.1#

Specifying Match Criteria for DLSw Priority Outbound Filters

For DLSw priority outbound filters, you can specify SAP source and destination 
addresses and MAC source and destination addresses as match criteria. Traffic 
that matches the configured match criteria for a filter is handled according to the 
configured filter actions.

To prepare to specify the filtering match criteria, navigate to the peer’s filter 
prompt (for example, box; dlsw; dlsw-priority-outbound-filter/ <filter_name>/ 
<peer_address>, and enter:

match

This action displays the priority outbound filter’s match prompt. For example, to 
display the match prompt for a filter named dsap_01and02_q3 for a peer with an 
IP address of 192.168.1.1, navigate to the peer’s filter prompt (box; dlsw; 
dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1# match

match/dsap_01and02_q3/192.168.1.1#

Specifying MAC destination addresses

To specify a MAC destination address as a filter criteria, navigate to the peer 
filter’s match prompt, (for example, box; dlsw; dlsw-priority-outbound-filter/ 
<filter_name>/ <peer_address>; match), and enter:

pri-dlsw-mac-dest-addr <address_range>

<address_range> is the range of MAC destination addresses for the filter in 
hexadecimal notation. Valid values are in the range of 0-FFFFFFFFFFFF, 
inclusive. For a range with only one value, enter only one MAC destination 
address. The BCC automatically uses that value for both the minimum and 
maximum values in the address range.

Note: The BCC does not support the use of predefined match criteria for FID2 
and FID4 frames in DLSw outbound filters in version 15.5.0.0, or earlier. 
However, Site Manager supports the use of these predefined match criteria.
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For example, to specify a range of MAC destination addresses from 0aaa to 0aab 
as a match criteria for a filter named dsap_01and02_q3 for a peer with an IP 
address of 192.168.1.1, navigate to the filter’s match prompt, (box; dlsw; 
dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match), and 
enter:

match/dsap_01and02_q3/192.168.1.1# pri-dlsw-mac-dest-addr {0aaa-0aab}

match/dsap_01and02_q3/192.168.1.1#

Specifying MAC source addresses

To specify a MAC source address as a filter criteria, navigate to the peer filter’s 
match prompt, (for example, box; dlsw; dlsw-priority-outbound-filter/ 
<filter_name>/ <peer_address>; match), and enter:

pri-dlsw-mac-src-addr <address_range>

<address_range> is the range of MAC destination addresses for the filter in 
hexadecimal notation. Valid values are in the range of 0-FFFFFFFFFFFF, 
inclusive. For a range with only one value, enter only one MAC source address. 
The BCC automatically uses that value for both the minimum and maximum 
values in the address range.

For example, to specify a range of MAC source addresses from 0000a2000001 to 
0000a2000003 as a match criteria for a filter named dsap_01and02_q3 for a peer 
with an IP address of 192.168.1.1, navigate to the filter’s match prompt, (box; 
dlsw; dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match), 
and enter:

match/dsap_01and02_q3/192.168.1.1# pri-dlsw-mac-src-addr 
{0000a2000001-0000a2000003}

match/dsap_01and02_q3/192.168.1.1#

Specifying SAP destination addresses

To specify a SAP destination address as a filter criteria, navigate to the peer filter’s 
match prompt, (for example, box; dlsw; dlsw-priority-outbound-filter/ 
<filter_name>/ <peer_address>; match), and enter:

pri-dlsw-dsap <address_range>
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<address_range> is the range of SAP destination addresses for the filter. Valid 
values are in the range of 0-65535, inclusive. For a range with only one value, 
enter only one SAP destination address. The BCC automatically uses that value 
for both the minimum and maximum values in the address range.

For example, to specify a range of SAP destination addresses from 1 to 2 as a 
match criteria for a filter named dsap_01and02_q3 for a peer with an IP address 
of 192.168.1.1, navigate to the filter’s match prompt, (box; dlsw; 
dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match), and 
enter:

match/dsap_01and02_q3/192.168.1.1# pri-dlsw-dsap {1-2}

match/dsap_01and02_q3/192.168.1.1#

Specifying SAP source addresses

To specify a SAP source address as a filter criteria, navigate to the peer filter’s 
match prompt, (for example, box; dlsw; dlsw-priority-outbound-filter/ 
<filter_name>/ <peer_address>; match), and enter:

pri-dlsw-ssap <address_range>

<address_range> is the range of SAP source addresses for the filter. Valid values 
are in the range of 0-65535, inclusive. For a range with only one value, enter only 
one SAP source address. The BCC automatically uses that value for both the 
minimum and maximum values in the address range.

For example, to specify a range of SAP source addresses from 4 to 5 as a match 
criteria for a filter named dsap_01and02_q3 for a peer with an IP address of 
192.168.1.1, navigate to the filter’s match prompt, (box; dlsw; 
dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; match), and 
enter:

match/dsap_01and02_q3/192.168.1.1# pri-dlsw-ssap {4-5}

match/dsap_01and02_q3/192.168.1.1#

Specifying the Action for DLSw Priority Outbound Filters

You can specify the following actions for DLSw priority outbound filters:

• queue—specifies to which DLSw priority queue (0-9) traffic that matches the 
filter’s match criteria will be sent
19-12 314470-15.5 Rev 00



Configuring DLSw Services
  
• action-log—specifies whether the router will send an entry to the system log 
file for traffic that matches the filter’s match criteria

To prepare to specify the filter action, navigate to the peer’s filter prompt (for 
example, box; dlsw; dlsw-priority-outbound-filter/ <filter_name>/ 
<peer_address>, and enter:

actions

This action displays the priority outbound filter’s actions prompt. For example, to 
display the actions prompt for a filter named dsap_01and02_q3 for a peer with an 
IP address of 192.168.1.1, navigate to the peer’s filter prompt (box; dlsw; 
dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1) and enter:

dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1# actions

actions/dsap_01and02_q3/192.168.1.1#

Specifying the Queue Action

To specify the priority queue for traffic that matches the filter’s match criteria, 
navigate to the peer filter’s actions prompt, (for example, box; dlsw; 
dlsw-priority-outbound-filter/ <filter_name>/ <peer_address>; actions), and 
enter:

queue <value>

<value> is the number of the DLSw priority queue for this filter. Valid values are 
from 0 to 9, inclusive.

For example, to specify queue 1 as the priority queue for a filter named 
dsap_01and02_q3 for a peer with an IP address of 192.168.1.1, navigate to the 
filter’s actions prompt, (box; dlsw; dlsw-priority-outbound-filter/
dsap_01and02_q3/192.168.1.1; actions), and enter:

actions/dsap_01and02_q3/192.168.1.1# queue 1

actions/dsap_01and02_q3/192.168.1.1#
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Specifying the Log Action

To specify the log action for traffic that matches the filter’s match criteria, 
navigate to the peer filter’s actions prompt, (for example, box; dlsw; 
dlsw-priority-outbound-filter/ <filter_name>/ <peer_address>; actions), and 
enter:

action-log {on | off}

on (the default) indicates that when an outbound packet matches the filter’s match 
criteria, the DLSw outbound priority filter adds an entry to the system log file.

off specifies that no DLSw outbound priority filter information is written to the 
system event log file.

For example, to turn off logging for a filter named dsap_01and02_q3 for a peer 
with an IP address of 192.168.1.1, navigate to the filter’s actions prompt, (box; 
dlsw; dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; actions), 
and enter:

actions/dsap_01and02_q3/192.168.1.1# action-log off

actions/dsap_01and02_q3/192.168.1.1#

For example, to turn logging on again for a filter named dsap_01and02_q3 for a 
peer with an IP address of 192.168.1.1, navigate to the filter’s actions prompt, 
(box; dlsw; dlsw-priority-outbound-filter/dsap_01and02_q3/192.168.1.1; 
actions), and enter:

actions/dsap_01and02_q3/192.168.1.1# action-log on

actions/dsap_01and02_q3/192.168.1.1#
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Chapter 20
Configuring Data Compression Services

Version 15.5.0.0

The following notice supplements Chapter 1, “Starting Compression Services,” in 
Configuring Data Compression Services.

Hi/fn LZS Compression on BayRS for Passport 2430 and Passport 
5430

Beginning with version 15.5.0.0, BayRS adds Hi/fn LZS (Lempel Ziv STAC) 
compression capability to the Passport 2430 and Passport 5430, thus, extending 
optional Hi/fn LZS compression capability to all BayRS router platforms.

The use of Hifn Compression improves the bandwidth utilization of a wide area 
network (WAN) link by removing redundancies in data traffic, which increases the 
effective throughput of the link. Hifn Compression is standards based and permits 
interoperability with third party routers.

For information on configuring Hi/fn LZS compression, see Configuring Data 
Compression Services.
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Chapter 21
Configuring GRE, NAT, RIPSO, and BFE Services

Version 15.5.0.0

The following information supplements Chapter 1, “Configuring GRE Tunnels,” 
in Configuring GRE, NAT, RIPSO, and BFE Services.

Configuring GRE Keepalive Functionality

Beginning with version 15.5.0.0, BayRS provides a more robust environment for 
packet forwarding over Generic Routing Encapsulation (GRE) tunnels by creating 
a keepalive mechanism that enables a router to monitor GRE traffic from a remote 
end point. When this feature is enabled, a router can verify that the status of a 
tunnel’s state is ‘up’ before it forwards packets over it.

You configure GRE keepalive functionality by performing the following tasks:

• Enabling or disabling keepalive messages

• Configuring the keepalive retry timeout interval

• Configuring the keepalive retries value

The output for the following BCC show commands is enhanced to provide 
information about the GRE keepalive mechanism:

• show gre logical-ip-tunnels

• show gre logical-ipx-tunnels

• show gre physical-tunnels

For information on the enhanced output to these BCC show commands, see 
Chapter 22, “Reference for BCC IP show Commands” in this document.
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Enabling and Disabling GRE Keepalive Messages for a Remote Tunnel 
End Point

The GRE keepalive message functionality is disabled by default.

You can use the BCC or Site Manager to enable and disable the transmission of 
GRE keepalive messages between a GRE tunnel’s local end point and one of its 
configured remote tunnel end points.

Using the BCC

To enable and disable the transmission of GRE keepalive messages between a 
tunnel’s local end point and one of its remote tunnel end points, navigate to the 
remote GRE tunnel interface prompt (for example, box; tunnels; gre/boston; 
remote-endpoint/austin) and enter:

keepalive <state>

state is one of the following:

enabled
disabled (default)

For example, the following command sequence enables transmission of GRE 
keepalive messages between the local end point and the remote end point austin 
and verifies the change:

remote-endpoint/austin# keepalive enabled
remote-endpoint/austin# info
address 192.168.2.4                                                                       
keepalive enabled                                                                      
logical-ip-address 0.0.0.1                                                              
logical-ipx-address 000000000001                                                        
name austin                                                                             
keepalive-retries 3                                                                     
keepalive-retry-timeout 10                                                              
state enabled 
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Using Site Manager

To enable and disable the transmission of GRE keepalive messages between a 
tunnel’s local end point and one of its configured remote end points, complete the 
following tasks:

Setting the Timeout Interval for GRE Keepalive Messages

When you enable the GRE keepalive message functionality, the timeout interval is 
set to 10 seconds by default. The timeout interval is the amount of time in seconds 
that the router waits between sending successive keepalive messages from a GRE 
tunnel’s local end point to one of its remote end points. 

You can use the BCC or Site Manager to change the value of the timeout interval.

Using the BCC

To change the default value of the GRE keepalive retry timeout interval for a GRE 
tunnel’s remote end point, navigate to the remote GRE tunnel interface prompt 
(for example, box; tunnels; gre/boston; remote-endpoint/austin) and enter:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose GRE. The GRE Create Tunnels List window 
opens.

4. Click on Remote Conn. The GRE Remote Connections List 
window opens.

5. Select the remote tunnel end point that 
you want to disable or reenable from the 
list.

6. Set the Keepalive parameter. Click on 
Help or see the parameter description on 
page A-14.

7. Click on Apply. The transmission of GRE keepalive 
messages is enabled or disabled for the 
selected tunnel end point.
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keepalive-retry-timeout-<value>

value is an integer between 1 and 32766, inclusive. It represents the number of 
seconds that the router waits between sending successive GRE keepalive 
messages from the GRE tunnel’s local end point to one of its remote end points.

For example, the following command sequence changes the keepalive retry 
timeout interval for the remote tunnel austin to 20 seconds and verifies the 
change:

remote-endpoint/austin# keepalive-retry-timeout 20
remote-endpoint/austin# info
address 192.168.2.4
keepalive enabled                                                                      
logical-ip-address 0.0.0.1                                                              
logical-ipx-address 000000000001                                                        
name austin                                                                             
keepalive-retries 3                                                                     
keepalive-retry-timeout 20                                                              
state enabled 

Using Site Manager

To change the default value of the GRE keepalive retry timeout interval for a 
remote tunnel end point, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose GRE. The GRE Create Tunnels List window 
opens.

4. Click on Remote Conn. The GRE Remote Connections List 
window opens.

5. Select the remote tunnel end point for 
which you want to set the keepalive retry 
timeout interval value from the list.
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Setting the Keepalive Retries Parameter for GRE Keepalive Messages

When you enable the GRE keepalive message functionality, the value of the 
keepalive retries parameter is set to 3 by default. The keepalive retries parameter is 
the multiplier used to calculate the amount of time that the router waits for a reply 
after sending a GRE keepalive message to a remote end point before declaring 
that the GRE tunnel is down. 

You can use the BCC or Site Manager to change the value of the timer interval.

Using the BCC

To change the default value of the GRE keepalive retries parameter for a remote 
tunnel end point, navigate to the remote GRE tunnel interface prompt (for 
example, box; tunnels; gre/boston; remote-endpoint/austin) and enter:

keepalive-retries <value>

value is an integer between 2 and 254, inclusive. The default value is 3. It 
represents the number by which to multiply the currently configured value of the 
keepalive retry timeout interval. For example, if the keepalive retry timeout 
interval is set to 20 (seconds) and you set the keepalive retries value to 6, then the 
router waits for 120 seconds (6 x 20 seconds) for a reply message before declaring 
that the GRE tunnel is down.

For example, the following command sequence changes the keepalive retries 
value for the remote tunnel austin to 6 times the current value of the keepalive 
timer interval (20) and verifies the change:

remote-endpoint/austin# keepalive-retries 6
remote-endpoint/austin# info
address 192.168.2.4
keepalive enabled                                                                      
logical-ip-address 0.0.0.1                                                              

6. Set the Keepalive Retry Timeout 
parameter. Click on Help or see the 
parameter description on page A-14.

7. Click on Apply. The GRE keepalive timer is set for the 
selected tunnel end point.

Site Manager Procedure (continued)

You do this System responds
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logical-ipx-address 000000000001                                                        
name austin                                                                             
keepalive-retries 6 
keepalive-retry-timeout 20                                                              
state enabled 

Using Site Manager

To change the default value of the GRE Keepalive Retries parameter for a remote 
tunnel end point, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose GRE. The GRE Create Tunnels List window 
opens.

4. Click on Remote Conn. The GRE Remote Connections List 
window opens.

5. Select the remote tunnel end point for 
which you want to set the keepalive retries 
value from the list.

6. Set the Keepalive Retries parameter. 
Click on Help or see the parameter 
descriptions beginning on page A-14.

7. Click on Apply. The GRE keepalive retries value is set for 
the selected tunnel end point.
21-6 314470-15.5 Rev 00



  
Chapter 22
Configuring IP Exterior Gateway Protocols

(BGP and EGP)

Version 15.5.0.0

The following section is an update to Chapter 1, “Exterior Gateway Protocols 
(BGP and EGP)” in Configuring IP Exterior Gateway Protocols (BGP and EGP).

BGP Implementation Notes

For BayRS release 15.5.0.0, 128 MB of optional memory is available for the 
Passport 5430. The standard 64 MB of memory on the Passport 5430 is no longer 
adequate to run the full complement of Internet routes, which currently can be as 
many as 125,000 routes. Therefore, it is recommended that you upgrade to 128 
MB of memory if you want to run full Internet routes on a Passport 5430. Because 
of this situation, the following update to the BGP Implementation Notes is 
necessary:

To configure BGP and download full Internet routes on the Passport 5430 
Multiservice Access Switch, you must install the router with 128 MB of memory.

For additional information, refer to the “BGP Guidelines” section of the Release 
Notes for BayRS Version 15.5.0.0
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Reference for BCC IP show Commands

Version 15.5.0.0

The following information supplements the information provided in Chapter 4, 
“GRE show Commands” of the Reference for BCC IP show Commands.

Modified Output for the GRE Keepalive Mechanism

The output for the following BCC show commands was modified to support the 
GRE keepalive feature introduced in version 15.5.0.0:

• show gre logical-ip-tunnels

• show gre logical-ipx-tunnels

• show gre physical-tunnels

For information on the modified output to these BCC show commands, see the 
following sections.
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show gre logical-ip-tunnels

The show gre logical-ip-tunnels command displays information about the 
logical IP connections configured on a GRE tunnel. This command allows for the 
following command filters and arguments:

The output includes the following information:

-disabled Displays information about disabled tunnels only.

-enabled Displays information about enabled tunnels only.

-address <address> Displays information for tunnels configured with the 
specified IP address only.

-name <name> Displays information for tunnels configured with the 
specified tunnel name only. When you specify this filter, it 
displays both the filter flag and value (that is, long 
notation).

<name> Displays information for tunnels configured with the 
specified tunnel name only. When you specify this filter, it 
displays a value only (that is, short notation).

Tunnel Name Name assigned to the GRE tunnel.

Local Address IP address of the host interface on the local end of the 
GRE tunnel connection.

Local State State of the local host interface: enabled or disabled.

Remote Endpoint Name Name assigned to the host interface on the remote end of 
the GRE tunnel connection.

Remote Endpoint Address IP address assigned to the host interface on the remote 
end of the GRE tunnel connection.

Keepalive: Enabled? If enabled, indicates that keepalives will be sent to the 
remote endpoint and keepalives received from that 
endpoint will be acted upon: enabled or disabled.

State State of the GRE connection: up or down. The state of a 
connection is ‘up’ unless it is declared ‘down’ (as a result 
of keepalive failure) or the GRE connection is disabled.
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show gre logical-ipx-tunnels

The show gre logical-ipx-tunnels command displays information about the 
logical IPX connections configured on a GRE tunnel. This command allows for 
the following command filters and arguments:

The output includes the following information:

Timer Interval of time (in seconds) between transmission of 
successive keepalive packets to the remote endpoint.

Retries Amount of time to wait before declaring a GRE 
connection ‘down’. ‘Retries’ is expressed as a multiple of 
the configured Timer value, where “Retries” is the number 
by which the Timer value is multiplied.

-disabled Displays information about disabled tunnels only.

-enabled Displays information about enabled tunnels only.

-address <address> Displays information for tunnels configured with the 
specified IP address only.

-name <name> Displays information for tunnels configured with the 
specified tunnel name only. When you specify this filter, it 
displays both the filter flag and value (that is, long 
notation).

<name> Displays information for tunnels configured with the 
specified tunnel name only. When you specify this filter, it 
displays a value only (that is, short notation).

Tunnel Name Name assigned to the GRE tunnel.

Local Network Address Address of the host interface on the local end of the GRE 
tunnel connection.

Local State State of the local host interface: enabled or disabled.

Remote Endpoint Name Name assigned to the host interface on the remote end of 
the GRE tunnel connection.

Remote Endpoint Address Name of the host on the remote end of the GRE tunnel 
connection.

Keepalive: Enabled? If enabled, indicates that keepalives will be sent to the 
remote endpoint and keepalives received from that 
endpoint will be acted upon: enabled or disabled.
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show gre physical-tunnels

The show gre physical-tunnels command displays information about the router 
interfaces at either end of the physical GRE tunnel. This command allows for the 
following command filters and arguments:

The output includes the following information:

State State of the GRE connection: up or down. The state of a 
connection is ‘up’ unless it is declared ‘down’ (as a result 
of keepalive failure) or the GRE connection is disabled.

Timer Interval of time (in seconds) between transmission of 
successive keepalive packets to the remote endpoint.

Retries Amount of time to wait before declaring a GRE 
connection ‘down’. ‘Retries’ is expressed as a multiple of 
the configured Timer value, where “Retries” is the number 
by which the Timer value is multiplied.

-disabled Displays information about disabled tunnels only.

-enabled Displays information about enabled tunnels only.

-address <address> Displays information for tunnels configured with the 
specified IP address only.

-name <name> Displays information for tunnels configured with the 
specified name only. When you specify this filter, displays 
both the filter flag and value (that is, long notation).

<name> Displays information for tunnels configured with the 
specified tunnel name only. When you specify this filter, 
displays a value only (that is, short notation).

Tunnel Name Name assigned to the GRE tunnel.

Local Address IP address of the router interface on which the GRE 
tunnel is configured.

Local State State of the router interface: enabled or disabled.

Remote Endpoint Name Name assigned to the interface at the tunnel’s remote end 
point.

Remote Endpoint Address IP address of the interface at the tunnel’s remote end 
point.

Encaps Protocols Protocol for which the tunnel is configured.
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Keepalive: Enabled? If enabled, indicates that keepalives will be sent to the 
remote endpoint and keepalives received from that 
endpoint will be acted upon: enabled or disabled.

State State of the GRE connection: up or down. The state of a 
connection is ‘up’ unless it is declared ‘down’ (as a result 
of keepalive failure) or the GRE connection is disabled.

Timer Interval of time (in seconds) between transmission of 
successive keepalive packets to the remote endpoint.

Retries Amount of time to wait before declaring a GRE 
connection ‘down’. ‘Retries’ is expressed as a multiple of 
the configured Timer value, where “Retries” is the number 
by which the Timer value is multiplied.
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Appendix A
Site Manager Parameters

This appendix describes the following Site Manager parameters:

Topic Page

Adjacent Host Parameter A-3

ATM Line Parameters A-3

ATM Port Parameters A-3

Automated Security Association (IKE) Parameters A-10

BGP-3-Specific Announce Policy Parameter A-11

BGP-4-Specific Announce Policy Parameter A-12

Frame Relay PVC Parameter A-13

GRE Remote Connection Parameters A-14

IGMP Static Forwarding Policy Parameters A-16

IP Global Parameters A-18

IP PIM Parameter A-20

NAT Global Parameter A-21

OSPF Global Parameters A-22

OSPF Area Parameters A-22

OSPF/RIP Announce Policy Parameter A-23

PPP Interface Parameter Descriptions A-25

PPP Multilink Multiclass Classes Parameter Description A-26

QLLC Mapping Table Configuration Parameter A-24

RADIUS Access Control Parameters A-27

RADIUS Client Parameters A-28

RIP Parameter A-30
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You can display the same information using Site Manager online Help.

For each parameter, this appendix provides the following information:

• Parameter name

• Configuration Manager menu path

• Default setting

• Valid parameter options

• Parameter function

• Instructions for setting the parameter

• Management information base (MIB) object ID

You can also use the Technician Interface to modify parameters by issuing set
and commit commands with the MIB object ID. This process is the same as
modifying parameters using Site Manager. For information about using the
Technician Interface to access the MIB, refer to Using Technician Interface
Software.

VRRP Parameter A-31

X.25 Network Service Record Parameter A-31

Caution: The Technician Interface does not verify that the value you enter for
a parameter is valid. Entering an invalid value can corrupt your configuration.

Topic Page
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Adjacent Host Parameter

You use the following parameter to configure the local IP address for an adjacent 
host.

ATM Line Parameters

You use the following parameters to configure ATM line details on the Passport 
5430. The type of ATM link module you use determines the line details that you 
can edit.

Parameter: IP Local Address

Path: Configuration Manager > Protocols >IP > Adjacent Hosts
Default: 0.0.0.0
Options: Any valid IP address

Function: Specifies the IP address of the local IP interface. The adjacent host must be on 
the same subnet as the local IP interface.

Instructions: Enter the IP address in dotted-decimal notation.
MIB Object ID:. N/A

Parameter: Enable

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Enable
Options: Enable | Disable

Function: Enables or disables the line driver.
Instructions: Select Enable or Disable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.2
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Parameter: Interface MTU

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: 4608
Options: 0 to 9188

Function: Specifies the largest packet size (in octets) that the router can transmit on this 
interface.

Instructions: Enter a value that is appropriate for the network.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.9

Parameter: Data Path Enable

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether the router disables the interface between the driver and the 
higher-level software (the data path interface) when you disconnect the cable 
from the ATM module.

If you select Enable, then when you disconnect the cable from the ATM 
module, the router disables the data path interface after the time you specify 
with the Data Path Notify Timeout parameter.

If you select Disable, the router does not disable the data path interface when 
you disconnect the cable from the ATM module.

Instructions: Select Enable or Disable. If you select Enable, be sure to enter an appropriate 
value for the Data Path Notify Timeout parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.11

Parameter: Data Path Notify Timeout

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: 1
Options: 0 to 3600

Function: Specifies the time (in seconds) that the router waits before disabling the data 
path interface when you disconnect the cable from the ATM module, providing 
that you set the Data Path Enable parameter to Enable.

Instructions: Accept the default or enter an appropriate value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.12
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Parameter: Framing Mode

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: DS3_CBIT (for DS3 lines) | E3_G832 (for E3 lines) | T1ADM (for DS1 lines) | 

E1ADM (for E1 lines)
Options: DS3_CBIT | DS3_M32 | T3CBITTPLCP | T3M23PLCP | E3_G751 | E3_G832

Function: Specifies the transceiver mode for the physical interface.
Instructions: Select a transceiver mode as follows:

• DS3_CBIT, DS3_M32, T3CBITTPLCP, or T3M23PLCP for DS3 modules
• E3_G751 or E3_G832 for E3 modules

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.17

Parameter: Cell Scrambling (Passport 5430)

Parameter: DS3/E3 Scrambling (BN)

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Off
Options: On | Off

Function: If you select On, the router randomizes cell payload sufficiently to guarantee 
cell synchronization. If you select Off, cell synchronization problems can occur.

Note that ATM devices with different settings for scrambling cannot 
communicate. For example, if you configure a router to enable scrambling and 
configure a hub to disable scrambling, the router and the hub cannot 
communicate.

Instructions: If you select On, be sure to enable scrambling for all devices on the network. If 
you select Off, be sure to disable scrambling for all devices on the network.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.22
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Parameter: Per-VC Clipping

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Disable
Options: Enable | Disable

Function: Enables or disables cell clipping on a per-VC basis. 
Instructions: Accept the default, Disable, for normal VC clipping. Enable this parameter if 

you want to clip cells on a per-VC basis.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.1.1.17

Parameter: DS3 Line Build Out

Path: Configuration Manager > ATM1 > ATM Line Attributes
Default: Short
Options: Short | Long

Function: Conditions router signals to mitigate attenuation, which depends on the physical 
length of the line.

You can set this parameter only for DS3 modules.
Instructions: Select Short for lines shorter than 225 feet; select Long for lines 225 feet or 

longer.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.23
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ATM Port Parameters

You use the following parameters to configure the ATM T3/E3 interface on the 
Passport 5430.

Parameter: Enable/Disable

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: Enable
Options: Enable | Disable

Function: Enables or disables this interface. 
Instructions: Set to Disable only if you want to disable the interface.

MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.2

Parameter: Line Type

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: Autodetect
Options: For DS3, the options are DS3 M23 | DS3 CBIT Parity | Autodetect

For E3, the options are E3 Framed | E3 PLCP
Function: Sets the frame format for this interface.

Instructions: Determines the framing mode for this interface.
For DS3, if you choose DS3 M23 or DS3 CBIT Parity, be sure that the ATM 
line attribute Framing Mode is appropriately set:

If the Line Type is DS3 M23, Framing Mode should be DS3_M23 or 
T3M23PLCP.

If Line Type is DS3 CBIT Parity, Framing Mode should be DS3_CBIT or 
T3CBITPLCP.

For E3, make sure that the ATM line attribute Framing Mode is set to either 
E3_G751 or E3_G832.

MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.7
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Parameter: Setup Alarm Threshold (seconds)

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: 2 
Options: 2 to 10

Function: Sets the time interval (in seconds) during which the device driver tolerates a 
performance defect or anomaly. If the performance defect or anomaly is still 
present when time interval expires, the device driver records a performance 
failure and logs an event message.

Instructions: Set the timer value in seconds.
MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.17

Parameter: Clear Alarm Threshold (seconds)

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: 2
Options: 2 to 10

Function: Specifies the clear time (in seconds) for performance failure conditions. If the 
defect or anomaly clears within this interval, the device driver records a 
performance cleared condition and logs an event message.

Instructions: Set the timer value in seconds.
MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.18
A-8 314470-15.5 Rev 00



Site Manager Parameters
  
Parameter: Loopback Configuration

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: No Loopback
Options: No Loopback | Payload Loopback | Line Loopback

Function: Forces the interface into loopback mode. The far-end or intermediate equipment 
then performs diagnostics on the network between that equipment and the T3/
E3 interface. After testing, set this parameter to No Loopback to return the 
interface to a normal operating mode.

• No Loopback — Returns the interface to non-loopback operation.
• Payload Loopback — The received signal at this interface is looped through 

the device. Typically the received signal is looped back for re-transmission 
after it has passed through the device’s framing function.

• Line Loopback — The received signal at this interface does not go through 
the framing device (minimum penetration) but is looped back out.

Instructions: Select the loopback configuration option.
MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.9

Parameter: Primary Clock

Path: Configuration Manager > ATM1 > Physical Layer Configuration > DS3 or E3
Default: Loop
Options: Internal | Loop

Function: Specifies the clock signal source.
Instructions: Select Internal if you want the router to generate the clock signal source. 

Otherwise, accept the default, Loop, if you want the clock signal source to be 
external to the router.

MIB Object ID: 1.3.6.1.4.1.18.3.4.26.10.1.11
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Automated Security Association (IKE) Parameters

You use the following parameters to define a cryptographic key for creating IKE 
SAs between routers.

Parameter: Pre-shared Key (ascii)

Path: Configuration Manager > Protocols > IP > IKE
Configuration Manager > Edit Circuit > Protocols > Edit IP > IKE

Default: None
Options: Up to 24 ASCII characters

Function: Used as a cryptographic key for creating IKE SAs between routers. IKE is then 
used to create automated SAs for data packets.

Instructions: Enter an ASCII string, up to 24 characters. Configure the same preshared key on 
the destination router.

MIB Object ID: None

Parameter: Pre-shared Key (hex)

Path: Configuration Manager > Protocols > IP > IKE
Configuration Manager > Edit Circuit > Protocols > Edit IP > IKE

Default: None
Options: Up to 24 bytes

Function: Used as a cryptographic key for creating IKE SAs between routers. IKE is then 
used to create automated SAs for data packets.

Instructions: Enter a hexadecimal number, up to 24 bytes. (Enter the prefix 0x before the 
digits.) Configure the same preshared key on the destination router.

MIB Object ID: 1.3.6.1.4.1.18.3.5.27.1.1.9
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BGP-3-Specific Announce Policy Parameter

You use the following parameter to specify one or more BGP peers.

Parameter: Outbound Peers

Path: Configuration Manager > Protocols > IP > Policy Filters > BGP-3 > 
Announce Policies

Default: An empty list
Options: A list of IP numbers

Function: Specifies the BGP router ID of the peer. To verify the router ID of the BGP 
peer, on the peer router, check the configured value for the Site Manager 
BGP Global parameter, BGP Identifier, or the BCC BGP parameter, 
router-id.

This policy applies to BGP advertisements authored by a router on this list, 
and applies only to BGP-sourced routes when BGP is included as a route 
source.

Instructions: Specify one or more IP addresses. Configure an empty list to indicate that 
this policy applies to BGP advertisements being sent to any peer.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.6.8.1.23
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BGP-4-Specific Announce Policy Parameter

You use the following parameter to specify one or more BGP peers.

Parameter: Outbound Peers

Path: Configuration Manager > Protocols > IP > Policy Filters > BGP-4 > 
Announce Policies

Default: An empty list
Options: A list of IP addresses

Function: Specifies the BGP router ID of the peer. To verify the router ID of the BGP 
peer, on the peer router, check the configured value for the Site Manager 
BGP Global parameter, BGP Identifier, or the BCC BGP parameter, 
router-id.

This policy applies to BGP advertisements authored by a router on this list, 
and applies only to BGP-sourced routes when BGP is included as a route 
source.

Instructions: Specify one or more IP addresses. Configure an empty list to indicate that 
this policy applies to BGP advertisements being sent to any peer.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.6.10.1.23
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Frame Relay PVC Parameter

You use the following parameter to specify the bandwidth threshold that you want 
to set for this frame relay PVC.

Parameter: Bw Threshold

Path: Configuration Manager > Protocols > Frame Relay > Services > PVCs
Default: 0
Options: 0 to maximum physical line speed (bits/s)

Function: Specifies the bandwidth threshold that you want to set for this PVC for traffic 
shaping purposes.

Instructions: To minimize starvation of normal- and low-priority traffic over a high-speed 
physical line (such as a 56 Kb/s lines over HSSI), set the bandwidth threshold to 
a value 3 to 10 times that set for the Throughput (CIR) parameter. Otherwise, 
accept the default, 0.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.9.2.1.58
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GRE Remote Connection Parameters

You use the following parameter to enable and disable the transmission of GRE 
keepalive messages from a GRE tunnel’s local endpoint to its remote endpoint.

You use the following parameter to specify the number of seconds you want the 
router to wait before sending another keepalive packet from the GRE tunnel’s 
local endpoint to its remote endpoint.

Parameter: Keepalive

Path: Configuration Manager > Protocols > IP > GRE > Remote Conn
Default: Disabled
Options: Enabled | Disabled

Function: Enables and disables the transmission of GRE keepalive messages between a 
GRE tunnel’s local endpoint and one of its configured remote tunnel endpoints.

Instructions: Set to enable to activate the transmission of GRE keepalive messages between a 
GRE tunnel’s local endpoint and one of its configured remote tunnel endpoints. 
Set to disable to stop the transmission of GRE keepalive messages between a 
GRE tunnel’s local endpoint and one of its configured remote tunnel endpoints

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.28.1.8

Parameter: Keepalive Retry Timeout

Path: Configuration Manager > Protocols > IP > GRE > Remote Conn
Default: 10 (seconds)
Options: 1 to 32,766 (seconds)

Function: Specifies the amount of time in seconds that the router waits between sending 
successive keepalive packets from the GRE tunnel’s local endpoint to the GRE 
tunnel’s remote endpoint. 

Instructions: Specify the number of seconds you want the router to wait before sending 
another keepalive packet from the GRE tunnel’s local endpoint to its remote 
endpoint.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.28.1.9
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You use the following parameter to specify the amount of time that the router 
waits for a reply to a GRE keepalive message before it declares that the GRE 
tunnel is down. 

Parameter: Keepalive Retries

Path: Configuration Manager > Protocols > IP > GRE > Remote Conn
Default: 3
Options: 2 to 254, inclusive

Function: Specifies the amount of time that the router waits for a reply to a GRE keepalive 
message sent from a GRE tunnel’s local endpoint to its remote endpoint before 
declaring that the GRE tunnel is down. This waiting period is calculated by 
multiplying the currently configured value of the Keepalive Retry Timeout 
parameter by the value of this parameter.

Instructions: Specify the number by which to multiply the currently configured value of the 
Keepalive Retry Timeout parameter in order to calculate the Keepalive Retries 
waiting period. For example, if the Keepalive Retry Timeout parameter is set to 
20 (seconds) and you set the value of this parameter to 6, then the router will 
wait 120 seconds (6 x 20 seconds) for a reply to the GRE keepalive message 
before declaring that the GRE tunnel is down.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.28.1.10
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IGMP Static Forwarding Policy Parameters

The following descriptions for setting IGMP static forwarding policy parameters 
supersede those shown in Configuring IP Multicasting and Multimedia Services. 
Use these parameters to specify multicast groups and sources for IGMP static 
forwarding policies.

Parameter: Groups

Path: Configuration Manager > Protocols > IP > Policy Filters > IGMP > Static 
Forwarding Entries

Default: An empty list
Options: Leave empty or specify one or more groups.

Function: Identifies which multicast host groups match this policy.
Instructions: If you want this filter to match all multicast host groups, do not enter a value 

in the Groups field.

To match specific groups, click in the parameter field. Then, click on the List 
button and complete the following fields:

Group: Enter the IP address (or range of addresses) for the group.

Mask: Enter the subnet mask for the group address (or range of addresses).

Match Criteria: Select Exact to match only the group with the specified 
address and mask, or select Range to match all groups in the specified range 
of group addresses and masks.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.6.20.1.5
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Parameter: Sources

Path: Configuration Manager > Protocols > IP > Policy Filters > IGMP > Static 
Forwarding Entries

Default: An empty list
Options: Leave empty or specify one or more multicast sources.

Function: Identifies which multicast sources match this policy.
Instructions: If you want this filter to match all multicast sources, do not enter a value in the 

Sources field.

To specify a particular multicast source (or range of sources), click in the 
parameter field. Then, click on the List button and complete the following 
fields:

Source Address: Enter the IP address of the device (or devices) sending the 
multicast data.

Source Mask: Enter the subnet mask for the source address (or range of 
addresses).

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.6.20.1.10
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IP Global Parameters

You use the following parameter to disable directed broadcast.

You use the following parameter to enable or disable ICMP ECHO request.

Parameter: Directed Broadcast

Path: Configuration Manager > Protocols > IP > Global
Default: Enable
Options: Enable | Disable

Function: When this parameter is enabled, a packet addressed to an IP broadcast address
goes to all systems on the target network. By default, directed broadcast is
enabled.

Caution: Internet service providers have reported forged ICMP echo request
packets sent to IP addresses (SMURF attacks), sometimes resulting in severe
network congestion. To prevent these attacks, directed broadcast must be
disabled.

Instructions: Accept the default, Enable, if you want the directed broadcast feature to be
enabled. Set to Disable if you want directed broadcast to be disabled.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.1.28

Parameter: Icmp Echo Request Unique Id

Path: Configuration Manager > Protocols > IP > Global
Default: Disable
Options: Enable | Disable

Function: When this parameter is enabled, a unique identifier is added to each ICMP echo
request message.

Instructions: Accept the default, Disable, if you do not want to add unique identifiers to
ICMP echo requests. Set to Enable if you want to add unique identifiers to
ICMP echo requests.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.1.31
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You use the following parameter to specify the maximum number of equal-cost
multipath support on the router.

Parameter: IP OSPF Maximum Path

Path: Configuration Manager > Protocols > IP > Global
Default: 1
Options: 1 to 5

Function: Specifies the maximum number of equal cost paths allowed for a network
installed by OSPF.

Instructions: Use the IP global Multipath Method parameter to enable multipath costs and
specify the method that IP uses to choose the next hop for a datagram.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.1.21
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IP PIM Parameter

You use the following parameter to determine whether the router interface will act 
as a PIM bootstrap border interface.

Parameter: Bootstrap Border

Path: Configuration Manager > Protocols > IP > PIM > Interface
Default: Disable
Options: Disable | Enable

Function: When you set this parameter to Enable, this PIM interface acts as a PIM
bootstrap border interface. A bootstrap border interface discards both incoming
and outgoing bootstrap messages. Incoming messages originate from other PIM
routers; outgoing messages originate from other PIM interfaces on the same
router. When you set this parameter to Disable, this interface operates in
accordance with RFC 2362; it accepts incoming messages and forwards
outgoing ones.

Instructions: Set to Enable if you want the interface to discard incoming and outgoing
bootstrap messages. Accept the default, Disable, if you want the interface to
accept incoming messages and forward outgoing messages.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.14.2.1.32
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NAT Global Parameter

The following parameter was used when upgrading from a pre-14.20 NAT 
configuration to a 14.20 or greater version of BayRS software. This parameter 
should be set to Enable.

Parameter: Install Private Address

Path: Configuration Manager > Protocols > IP > NAT > Global
Default: Enable
Options: Enable | Disable

Function: This parameter was added in BayRS 14.20 to address a compatibility issue
concerning non-DNS NAT translations when upgrading from a pre-14.20 NAT
configuration to a 14.20 or greater version of BayRS software. This parameter
should be set to Enable. Disabling this parameter can cause unpredictable
results.

Instructions: Accept the default, Enable.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.7.1.18
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OSPF Global Parameters

Use the following parameter to enable RFC 3101 forwarding address 
compatibility for an OSPF NSSA. 

OSPF Area Parameters

Use the following parameter to specify the autonomous system external (ASE) 
forwarding address of the type 7 NSSA link state database (LSDB).

Parameter: Rfc 3101 Compatibility Enable

Path: Configuration Manager > Protocols > IP > OSPF/MOSPF > Global
Default: Disable
Options: Enable | Disable

Function: Enables or disables RFC 3101 forwarding address compatibility for the OSPF 
NSSA. The setting for this parameter takes effect after restarting OSPF 
globally.

Instructions: Set to Enable if you want to use the forwarding address functionality and 
specify an ASE forwarding address for type 7 link state advertisements 
(LSAs). If this parameter is not enabled, any forwarding address specified in 
the NSSA Forward Address parameter is ignored.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.1.37

Parameter: NSSA Forward Address

Path: Configuration Manager > Protocols > IP > OSPF/MOSPF > Areas 
Default: None
Options: Any valid IP address in the network

Function: Specifies the forwarding address for type 7 link state advertisements 
(LSAs).

Instructions: Enter the IP address of the interface to be used as the ASE forwarding 
address. To use this parameter, you must first set the NSSA Originate Def 
Route parameter to Enable.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.3.2.1.16
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OSPF/RIP Announce Policy Parameter

You use the following parameter to specify one or more BGP peers for an OSPF 
or RIP announce policy.

Parameter: From BGP Peer

Path: Configuration Manager > Protocols > IP > Policy Filters > RIP > Announce 
Policies

Path: Configuration Manager > Protocols > IP > Policy Filters > OSPF > Announce 
Policies

Default: An empty list
Options: A list of IP addresses

Function: Specifies the BGP router ID of the peer. To verify the router ID of the BGP 
peer, on the peer router, check the configured value for the Site Manager BGP 
Global parameter, BGP Identifier, or the BCC BGP parameter, router-id.

This policy applies to BGP advertisements authored by a router on this list, and 
applies only to BGP-sourced routes when BGP is included as a route source.

Instructions: Click in the From BGP Peer field and then click on the List button. Specify one 
or more IP addresses. Use the default empty list to indicate that this policy 
applies to BGP advertisements from any router.

MIB Object ID: RIP: 1.3.6.1.4.1.18.3.5.3.2.6.2.1.19
MIB Object ID: OSPF: 1.3.6.1.4.1.18.3.5.3.2.6.4.1.19
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QLLC Mapping Table Configuration Parameter

You use the following parameter to enable or disable the XID Retry feature.

Parameter: XID Retry

Path: Configuration Manager > Circuits > Edit Circuits > Edit > X.25 Protocol > 
Service > QLLC

Default: Disable
Options: Enable | Disable

Function: Allows the QLLC service to retransmit the XID3 every 10 seconds to the QLLC
endstation until it receives a response. This ensures that the endstation will
receive the XID3 and establish a connection.

Instructions: Set this parameter to Enable to have QLLC retransmit the XID3 every 10
seconds.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.8.1.19
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PPP Interface Parameter Descriptions

Use the following parameters to configure the PPP interface parameters 
associated with the RFC 2686, “Multi-Class Extension to Multi-Link PPP” 
feature for BayRS. For information on configuring other PPP interface 
parameters, see Configuring PPP Services.

Parameter: Multilink MultiClass Enable

Path: Protocols > PPP > Interfaces
Default: Disable
Options: Enable | Disable

Function: Enables or disables Multilink Multiclass (RFC 2686) for this interface. This 
parameter is active only for Multilink.

Instructions: To start Multilink Multiclass on the selected interface, set this parameter to 
Enable.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.2.2.1.82

Parameter: Maximum Number of Classes

Path: Protocols > PPP > Interfaces
Default: 6
Options: 6

Function: Specifies the maximum number of classes that may be received or transmitted. 
This parameter is active only for Multilink Multiclass.

Instructions: This parameter is preset to 6. It is displayed for reference only and cannot be 
changed.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.2.2.1.83
314470-15.5 Rev 00 A-25



BayRS Version 15.5.0.0 Document Change Notice
PPP Multilink Multiclass Classes Parameter Description

Use the following guidelines to configure the Multilink Multiclass PPP Classes 
parameter. In the path name given, bold text indicates that in Site Manager, you 
access the PPP Multiclass Classes window by clicking on the Classes button on 
the PPP Interface Lists window.

PPP Line Parameter Description

Use the following guidelines to configure the PPP Line parameter associated with 
the RFC 2686, “Multi-Class Extension to Multi-Link PPP” feature for BayRS. In 
the path name given, bold text indicates that in Site Manager, you access the PPP 
Line Lists window by clicking on the Lines button on the PPP Interface Lists 
window. For information on configuring other PPP line parameters, see 
Configuring PPP Services.

Parameter: Fragment Size

Path: Protocols > PPP > Interfaces > Classes
Default: 80
Options: A value from 64 up to the maximum transmission unit for the circuit.

Function: Specifies the minimum size of a packet that Multilink will fragment for this 
class. This parameter is active only for Multilink Multiclass.

Instructions: Accept the default value or specify the required minimum packet size.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.2.6.1.3

Parameter: Multilink Multiclass for Dialup

Path: Protocols > PPP > Interfaces > Lines
Default: Disable
Range: Enable | Disable

Function: Enables or disables Multilink Multiclass (RFC 2686) for this line. This 
parameter is active only for Multilink on dial-up connections and applies only to 
incoming calls.

Instructions: To activate Multilink Multiclass on this dialup line, set this parameter to Enable.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.2.1.1.51
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RADIUS Access Control Parameters

You use the following parameters to modify router access.

Parameter: User Manager Lock

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Access
Control

Default: Disabled
Options: Enable | Disable

Function: Allows you to modify access to the router by enabling or disabling the user/
manager lock.

Instructions: Set to Enable to lock out the user and manager profile and allow access only by
individual users with a unique profile. Accept the default value, Disable, to
allow access by all users with the manager or user profile, in addition to users
with a unique profile.

Note: If the user/manager lock is enabled and the RADIUS server becomes
unavailable, the message “RADIUS wait state” appears in the User Manager
Lock field. When the RADIUS server becomes available, the value reverts to
Enable.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.22.1.10

Parameter: Login Accounting

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Access
Control

Default: Disable
Options: Enable | Disable

Function: Enables or disables login accounting.
Instructions: Set to Enable if you want RADIUS Accounting messages to be sent to the

RADIUS server. Accept the default value, Disable, to prevent RADIUS
accounting messages from being sent to the server.

MIB Object ID: 1.3.6.1.4.1.18.3.3.2.22.1.11
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RADIUS Client Parameters

You use the following parameters to configure a RADIUS client. This section 
replaces “Client IP Address Parameter” in Appendix A of Configuring RADIUS.

Parameter: Authentication

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create
RADIUS > Add

or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit
RADIUS

Default: Disable
Options: Enable | Disable

Function: Enables or disables the RADIUS client on the gateway.
Instructions: Set to Enable to activate the RADIUS client on the router. Accept the default

value, Disable, to deactivate RADIUS authentication.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.2

Parameter: Accounting

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create
RADIUS > Add

or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit
RADIUS

Default: Disable
Options: Enable | Disable

Function: Enables or disables RADIUS accounting.
Instructions: Set to Enable to activate RADIUS accounting. Accept the default value,

Disable, to deactivate RADIUS accounting.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.3
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Parameter: Client IP Address

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create
RADIUS > Add
or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit
RADIUS > Edit

Default: None
Options: A 32-bit IP address

Function: Identifies the RADIUS client. This address applies to the entire router.
Instructions: Enter the IP address of the router. If the RADIUS server is already configured,

Site Manager automatically supplies the address.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.5

Parameter: Debug Message Level

Path: Configuration Manager > Protocols > Global Protocols > RADIUS > Create
RADIUS > Add
or
Configuration Manager > Protocols > Global Protocols > RADIUS > Edit
RADIUS

Default: NODEBUG
Options: ONE | TWO | THREE | NODEBUG

Function: Assigns the level of RADIUS debug messages that the RADIUS client logs.
Instructions: Accept the default value, NODEBUG, unless you are specifically trying to

debug the connection.
MIB Object ID: 1.3.6.1.4.1.18.3.5.22.1.1.7
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RIP Parameter

You use the following parameter to specify whether the router imports RIP-1 
updates only, RIP-2 updates only, or both RIP-1 and RIP-2 updates from a 
neighbor router.

Parameter: RIP Compatible

Path: Configuration Manager > Protocols > IP > RIP Interfaces
Default: Disabled
Options: Enable | Disable

Function: Specifies whether RIP-1 accepts both RIP-1 broadcast and RIP-2 multicast
packets (and have RIP-2 always use multicast for transmitting updates), or
whether RIP-1 accepts RIP-1 broadcast and RIP-2 broadcast packets only
(RIP-1 will not accept RIP-2 multicast packets) and have RIP-2 broadcast the
packets, making it compatible with RIP-1.

Instructions: Accept the default, Disable, if you want RIP-1 to accept both RIP-1 broadcast
and RIP-2 multicast packets. Select Enable if you want RIP-1 to accept RIP-1
broadcast and RIP-2 broadcast packets only.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.2.2.1.22
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VRRP Parameter

You use the following parameter to enable or disable the VRRP ping feature.

X.25 Network Service Record Parameter

You use the following parameter to enable or disable the No Calling Address 
feature.

Parameter: VRRP Address Ping

Path: Configuration Manager > Protocols > Global Protocols > IP > VRRP
Default: Disable
Options: Enable | Disable

Function: Allows you to ping a master virtual router that is not the owner of the virtual
router IP address. This feature is useful for checking network connectivity.

Instructions: Set to Enable to allow the router to ping a master virtual router that is not the
owner of the virtual router IP address. Accept the default, Disable, to prevent
that master virtual router from responding to a ping. When this feature is
disabled, VRRP is in full compliance with RFC 2338.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.25.1.1.15

Parameter: No Calling Address

Path: Configuration Manager > Circuits > Edit Circuits > Choose an Interface >
Edit > X25 Protocol > Service

Default: Off
Options: On | Off

Function: Allows the router to accept incoming X.25 calls for QLLC service from devices
that do not have an X.121 calling address. Only one X.25 connection can be
supported at any given time.

Instructions: Set this parameter to On to allow the router to accept incoming X.25 calls for
QLLC service from devices that do not have an X.121 calling address.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.4.2.1.55
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Hi/fn LZS compression for, 20-1

PC, Site Manager requirements, 17-3

PIM bootstrap border router, configuring, 9-1

policy parameters
Outbound Peers (announce), A-11, A-12

PPP
disabling multiclass extension to multilink, 18-3, 

18-4
disabling multilink multiclass on dial-up lines, 18-7, 

18-8
enabling multiclass extension to multilink, 18-3
enabling multilink multiclass on dial-up lines, 18-7, 

18-8
multiclass extension to multilink, 18-1, 18-3, 18-4, 

18-5, 18-6, 18-7, 18-8
specifying fragment size for multiclass extension to 

multilink, 18-5, 18-6

Priority parameter, 5-2

product support, xvii

prom command, 17-5

PROMs
upgrading and verifying, 17-5

protocol prioritization
configuring, 13-2
defined, 13-21
interoperability with DSQMS, 5-10

publications
hard copy, xvii

PVCs, deleting from service records, 7-2

Q

QLLC mapping table configuration parameter 
description, XID Retry, A-24

QLLC service, accepting incoming X.25 calls for, 15-2

QLLC XID Retry, enabling, 15-1

R

RADIUS
authentication and SecurID, 10-5
configuring client, 10-1
configuring login accounting, 10-4
configuring the user/manager lock, 10-2

RADIUS access control parameter descriptions, A-27

RADIUS client parameter descriptions, A-28

RED parameters, modifying, 5-1, 19-1, 20-1, 21-1, 
23-1

reenabling
GRE

remote tunnel end point, 21-2

remote tunnel end point (GRE)
disabling, 21-2, 21-3, 21-5
reenabling, 21-2

RFC 3101 Forwarding Address Compatibility for 
OSPF NSSA, 8-8, 8-9, 8-10

RFC826 description, 8-1

S

scripts, using to dynamically configure a router, 11-1

Seconds between Xmit of Echo-Request parameter, 
A-26

show dsqms queue stats command, 5-9

Site Manager, upgrade prerequisites, 17-3
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SNMP, configuring trap port, 2-1

Sources parameter
IGMP static forwarding policies, A-17

SPARCstation, system requirements, 16-1

Sun SPARCstation, Site Manager requirements, 17-3

support, Nortel Networks, xvii

SVC Inactivity Timeout
enabling/disabling, 3-8
specifying, 3-8

system requirements for Site Manager, 17-3

T

tagged frames (802.1Q), 6-2

technical publications, xvii

technical support, xvii

text conventions, xiv

traffic filter actions
High, 13-21
Length, 13-21
Low, 13-21
No Call, 13-23
No Reset, 13-23

traffic filters
outbound

High action, 13-21
Length action, 13-21
Low action, 13-21
No Call action, 13-23
No Reset action, 13-23

traffic shaping, enabling using Site Manager, 7-1

translation bridge implementation note, 4-1

trap messages, trap port setup, 2-1

tunnels
GRE, 23-2

U

upgrading boot and diagnostic PROMs, 17-1

upgrading existing configuration files, 17-8

upgrading Site Manager, prerequisites, 17-3

user/manager lock, 10-2

user-defined criteria, specifying, 13-24

using the BCC
to specify the ip-net-ring-id for SRB, 4-2

V

VRRP Address Ping parameter description, A-31

VRRP parameter description, VRRP Address Ping, 
A-31

VRRP ping, enabling, 14-1

X

X.25 network service record parameter description, No 
Calling Address, A-31

XID Retry parameter description, A-24
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